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Preface

FHAES (Fire History Analysis and Exploration System) is a revision of the original FHX2 program written by
Dr. Henri Grissino-Mayer designed for the analysis of chronologies of fire scars developed from tree-ring data
(and can be used to analyze chronologies of other disturbance events). The original FHX2 program was written
in Pascal and Fortran and uses proprietary graphics software. It provides the means to enter and store fire
history data, graph and plot these data, statistically analyze the fire chronologies, and evaluate the relationship
between fire occurrence and climate condition. This program has been widely used and considered to be the
standard for fire history analysis, but will only run on Microsoft Windows operating systems, XP or earlier, or
for higher versions by using a DOS emulator. This revised system, now renamed FHAES (Fire History Analysis
and Exploration System), is completely re-written in Java and builds upon a variety of open source libraries.
Downloads are available for Windows, Mac OSX and Linux.

FHAES is open source software (see the details of the license on pages 51-56), so you are welcome to inspect
and edit the code. Please contact the authors if you'll like to find out how you can contribute.

We wish to acknowledge the contributions of NOAA's Paleoclimatic Division, Boulder, Colorado in early
coordination and development of this project. We mention with gratitude the contributions of the late Michael
Hartman who set up NOAA's International Multiproxy Paleofire Database, and worked to coordinate this project
with it. We also acknowledge the important role of Wendy Gross, who programmed the FHChart module and
who also set up the original FHAES website on FRAMES. Also thanks to Evan Larson and Kun Tian who have
supervised the development of the FHRecorder module by students at the University of Wisconsin-Platteville.

We hope that you find FHAES useful and look forward to hearing your feedback.

Elaine Kennedy Sutherland
USDA Forest Service
Rocky Mountain Research Station

Peter Brewer
University of Arizona
Laboratory of Tree-Ring Research

Henri Grissino-Mayer
University of Tennessee
Department of Geography

Maria Elena Velasquez
Boise State University
Department of Mathematics

Donald A. Falk

University of Arizona

School of Natural Resources and the Environment
and Laboratory of Tree-Ring Research

Peter Brown
Rocky Mountain Tree-Ring Research, Inc.
Fort Collins, Colorado

Connie Woodhouse
University of Arizona
School of Geography and Development
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Chapter 1

Introduction

1.1 What is FHAES?

FHAES (Fire History Analysis and Exploration System) is a software tool to evaluate fire regime properties such
as frequency, seasonality, extent, and fire/climate relationships from fire scars (fire-caused injuries on trees).
FHAES can also be used to calculate similar properties for other events that create unique signatures, like light
rings from insect infestations or frost rings resulting from volcanic eruptions. As input, FHAES requires data
in the the Fire History Exchange (FHX) format, similar to FHX2 (Grissino-Mayer, 2001). The techniques of
fire history analysis FHAES is built on assumes the user applied dendrochronological cross-dating methods to
determine calendar year dates of annual tree rings and the characteristics of fire scars (Stokes and Smiley 1968,
Fritts 1976, Holmes 1983, Dieterich and Swetnam 1984, Baisan and Swetnam 1990).

1.2 Comparing FHAES and FHX2

FHX2 (Grissino-Mayer, 2001) has long been the standard for fire history analysis. Copyrighted by Henri D.
Grissino-Mayer, it is a mix of Pascal and Fortran, and includes proprietary graphics software (Golden Software,
Inc.). It runs on Microsoft Windows operating systems, XP or earlier, and will run on other operating systems
by using a DOS emulator.

FHAES is a comprehensive reimplementation of most of FHX2's functions. It is written as an open source,
cross-platform, GUI application. FHAES will run on all modern operating systems (including 32 and 64 bit
versions) and takes advantage of improvements in memory to analyze larger and longer datasets. In addition
to reimplementing functionality provided by FHX2, FHAES also includes additional features that you may find
useful.

We hope that those of you familiar with FHX2 will find transitioning to FHAES quite simple. It is, however,
important to understand that results produced by FHAES in some cases will not be identical to those produced
by FHX2. For instance there are differences in the precision of floating point numbers (especially for provided
numbers like 7) between Pascal and Java. There are also different—yet equally valid—methods for performing
certain calculations. For example, Henri Grissino-Mayer generously provided the source code from FHX2 for
us to work from when we were re-coding FHAES. Unfortunately, the code for the Weibull function in FHX2
is a closed source binary (compiled Fortran code) so we had no way to determine its precise implementation.
Within FHAES, however, all functions are open source and can be inspected by anyone interested in how the
calculations are performed.

We are confident that the results produced by FHAES are identical, equivalent or more precise than those
provided by FHX2. If, however, you feel that you have an example dataset which illustrates a degradation in
the results produced by FHAES over FHX2, then we urge you to contact the authors so that we can, with your
assistance, investigate thoroughly.

Not every facet of FHX2 has been replicated in FHAES. While much of the output has been formatted as
text and in spreadsheets, not all the earlier output tables are available at this time. That can change, with
user input. There is no test for differences between two time periods or two subsamples of a site ("spatial
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differences”). If users express that some component of FHX2 was important to their work and is now missing
from FHAES, please let us know and we'll do our best to redevelop it in FHAES (fhaeshelp@gmail.com).

1.3 Where can | get help?

This manual is the main source for information about FHAES and how to run it. If you can’t find the answer
to your questions here, you can email the developers at fhaeshelp@gmail.com or through the contact form
on the FHAES website. Another source is the ITRDB forum mailing list, especially if your question is with
regards an academic issue as many of the world's leading dendropyrologists are members. Although right now
the manual is more about which buttons to push to make the program work, we will continue to add descriptive
information and examples.


fhaeshelp@gmail.com
fhaeshelp@gmail.com

Chapter 2

Installation

2.1 Requirements

FHAES will run on any relatively modern operating system, the only requirement being that Java 6 or later is
installed. We do, however, highly recommend using Java 7 for FHAES (and for any other Java application)
because Java 6 has passed its end-of-life and security updates are no longer released. Only use Java 6 if you
have a compelling reason to do so, for example you are running an older versions of OSX that does not readily
support Java 7. As with all aspects of FHAES, if you run up against any specific problems installing and
running FHAES then please get in touch with the developers for assistance.

2.2 How to install FHAES

Installation packages for the FHAES are available for Windows, MacOSX and Linux. For users of other
operating systems FHAES can be run from an executable JAR file.

To install FHAES, download the installation file for your operating system from
» http://download.fhaes.org/
The website should provide you with a link to the installer for your current operating system.

£7 Windows — Run the setup.exe and follow the instructions. If you do not have Java installed the installer
will direct you to the Java website where you can get the latest version. Once installed, FHAES can be
launched via the Start menu. Although FHAES should run on all version of Windows back to Windows
98, testing has been focused on Windows 7 and 8.

& Mac OSX - To install FHAES, download then open the zip file and drag the FHAES.app into your
applications folder. In theory, FHAES should be able to run on any version of OSX that runs Java 6,
however no testing has been done prior to Intel version 10.6 - Snow Leopard.

2 Ubuntu Linux — A Deb file is available which was designed for use on Ubuntu distributions but should work
on any Debian based system. Install using your favorite package management system. On Ubuntu and
similar distributions, the package should add a FHAES shortcut to your applications menu. Alternatively
you can start FHAES from the command line by typing fhaes.

® Redhat Linux — An RPM file is available which was designed for use with Redhat but should work on any
Linux Standard Base (LSB) distribution such as SUSE, Mandriva, Fedora etc. Install using your favorite
package management system. Note that due to the variation in naming conventions for Java between
these distributions, the RPM does not include Java as a dependency. You will, however, need to install
Java for FHAES to work.

£ Other operating systems — Make sure you have Java 6 or later installed, then download the FHAES JAR
file to your hard disk. You can run FHAES from the command line by typing:

java —jar fhaes.jar


http://download.fhaes.org/
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2.3 How to uninstall FHAES

We understand that FHAES will never suit the requirements of all users, but as an open source product, we

would really appreciate feedback as to why it didn't work for you. Without this feedback it is difficult to
prioritize future development.

For Windows users, FHAES can be uninstalled using the standard add/remove programs feature in control
panel. Mac users should simply delete the application from their applications folder. Linux users should use
their prefered package management tool e.g. from the Ubuntu command line:

sudo dpkg --remove fhaes



Chapter 3

Getting started

If you have not yet done so, please install FHAES using the instructions for your particular operating system
on page 7.

3.1 Main screen

Once you launch FHAES you will be greeted by the standard FHAES home screen. Now load!. You enter
new FHX format data by using the data entry module in FHAES. This is accessed by using the - icon on the
toolbar, or by using the File > New menu. Further information about the structure of FHX files and data entry
is available in chapter 4.

& FHAES - Fire History Analysis and Exploration System & &) &
File Edit Tools Help
O A W, == 4
«B Bl B A oneos
2 Analysis option Help
4
1 Y\:FH-E analysis re...
v [ Interval an...
B summan,
B Exceesdence table
v [ seaso...
I Summan
¥ (@ Binary summary mat...
[ Binary site summary
B Binary tree summary
B NTP Matri
| Create a new FHX file 'DEi|.1\ mparison mat...
[ B Matric A (1-1
J_L B Matrix B (0-1
. Load existing FHX file(s) I Matri C (1
 — B Matrix C
B Matrix L (sum
¥ [ similarity mat...
B JACCARE
[ coHEN
¥ (@ Dissimilarity mat...
B JacCARE
HEM
order: |None A —lnnalyms results . JFMeVlewer L lF\Ie summary ﬁlMap §s J

Figure 3.1: The FHAES home screen that it displayed on startup. To begin using FHAES select either ‘Create new
FHX file" or 'Load existing FHX file(s)'.

1If you do not have any FHX data files but would like to test FHAES, you can download data from NOAA's International
Multiproxy Paleofire Database http://www.ncdc.noaa.gov/paleo/impd/ or create one or more new FHX files (figure 3.1). There
is also a small sample dataset available from the FHAES software download page.


http://www.ncdc.noaa.gov/paleo/impd/
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If you already have FHX files these can be loaded by using the ‘open file' icon on the toolbar, through the File
-> Open menu, or by dragging and dropping files from your operating system'’s file manager application onto
the file list panel.

3.1.1 Analysis options

Once files are loaded or created you will be presented with the ‘Analysis options’ dialog. TIP: You should always
run the analysis even if you aren't interested in performing it because several of the tools in FHAES cannot
function without the analysis results. The dialog is split into three groups of fields: analysis options; filters and
years; and seasons. Each of the fields includes a help tip button to provide you with more information after
what the parameter means and it's implications for the analysis. This information is also reproduced below:

Event type for analysis — Select whether to perform analyses on:
» only fire events (upper case letters in the input files)
» only other indicators (lower case letters)
» both fire events and other indicators

Note that choosing one of the first two options may remove one or more of your input files from the
analyses if they do not contain enough of the specified event types.

Label results by — Select how you would like to label the input files in your results tables and charts. Note
that FHAES will default to file name if you pick site name or code and a file is missing the relevant
header information.

Interval analysis type — Select whether you want to perform analyses based separately upon each sample in
your file or by combining samples within a file into a composite. Note if you select ‘composite’ then you
may like to set composite filter options as well.

Include intervals after last event — Indicate whether you'd like to treat the interval from the final event
marker until the end of the series as an interval or not during interval analyses.

Alpha value — The alpha value or error is the maximum probability that a given return interval will be
significantly short or long. The default alpha value for this two-tailed test is 0.125.

Common years required — Select the number of common years or overlap that must be present between two
datasets before comparison matrices can be calculated.

First season combination — Scar positions (in the earlywood, latewood, or between growth rings) are com-
pared for differences based on some hypothesis. A common hypothesis would be that most fires occurred
in the typical wildland fire season for the locale (first season combination) and rarely occurred in the
second season combination.

Second season combination — The second season combination are scar positions being compared to the first
season.

Year range — the default option is that the analyses are calculated across the entire range of years in your
input files, or you may specify a more restricted time period.

Composite fire threshold — Specify how the composite of your samples should be filtered during analyses
(number or percentage). If you choose ‘number of fires' with a value of 1 then all fire events will be
used. The 'percentage of fires' value is continuous and ranges from 1 to 99. The larger the filter, the
more that extensive events in the record are emphasized.

The analysis options dialog will open automatically each time you load FHX files. If you want to repeat analyses
without being asked to confirm options each time you can choose to use the same choices without being asked
to confirm for the rest of the session. The next time you load FHAES, although it will remember you preferred
analysis options, you will be shown the options dialog and asked to confirm them again. Once you confirm your
analysis options FHAES will perform the calculations and populate the tabs on the home screen (see figure
3.2).
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e FHAES - Fire History Analysis and Exploration System ¥ & &
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Figure 3.2: The left panel shows the FHX files that are currently loaded and the right tabbed panel contains details
about the selected file and results of the fire history analyses. Note that the file list contains one file (us101001.fhx)
that has been determined to contain errors, and three that contain no fire events. The ‘File viewer' tab is open and
contains a view of the erroneous file us101001.fhx. FHAES is highlighting the error in the file and is explaining the error
in the message at the top of the screen.

3.1.2 File list

FHAES uses the TRICYCLE dendro converter library (Brewer et al., 2011) which makes use of the Tree Ring
Data Standard (TRiDaS — Jansma et al., 2010) to load files you have chosen and check they are valid. FHX
files that are determined to be invalid are indicated by a red cross icon @ in the file list, while valid files are
denoted by a green tick @. Files marked with an amber exclamation mark 2 are technically valid FHX files
but contain no valid event data (FHX demography files for instance) and are therefore excluded from analyses.
Erroneous files can be corrected by double clicking the appropriate file in the list and then using the FHAES
data entry screen (see pages 15-20).

The file list can be sorted using the drop down menu at the bottom of the screen. This can be helpful as the
order of the files in the list will also be reflected in the order the analysis results will be presented.

The following sections describe the contents of the various tabs in the right hand panel of the main screen.

3.1.3 File viewer tab

The ‘File viewer' tab displays the contents of the currently selected file in the file list (see figure 3.2). If this
file has been determined to be invalid (i.e. it is marked by red cross @ symbol) then a message is shown at
the top of the screen. Where possible, FHAES will also highlight the line where the error exists. You can edit
existing files by right clicking and choosing edit, or by using the equivalent toolbar or menu options.



12 FHAES: Fire History Analysis and Exploration System

3.1.4 Summary tab

The ‘File summary’ tab contains a report summarising the contents of the file currently selected in the file list.
The summary includes details about how many samples there are in the file, dates for the start and end of
each sample, number of events; average number of years for each fire event etc.

3.1.5 Map tab

The ‘Map’ tab contains an interactive map displaying the location of the sites described by the latitude and
longitude of currently loaded files. You can choose between a variety of background styles, zoom to the current
map pins, and also turn the pin labels on or off using the buttons at the top of the page.

Please note that the latitude and longitude fields in FHX files are free-text and can therefore be in a wide
variety of formats. FHAES will do its best to parse these fields to ascertain the coordinates, however, this may
fail in which case you will be warned. Please also note that in addition to lat/long fields FHX format files
also contain location information in UTM and township/range fields. Because there is no field in FHX files
for recording the UTM zone which is essential for the eastings and northings to make sense, UTM information
is disregarded by FHAES. Due to the huge potential variability of townshop/range data and the very limited
use of these fields in FHX, they are also disregarded by FHAES. We strongly recommend using standardized
WGS84 decimal latitude and longitude in your FHX files.

FHAES uses the latitude and longitude fields in all spatial analyses. For further information see sections 3.2.4
and 3.2.5.

3.1.6 Analysis results tab

The ‘Analysis results’ tab contains the results of all the analyses performed by FHAES. A categorized list shows
all the available results on the right, while the table on the left shows the currently selected result. A full
description of each of the analyses is provided in chapter 5 as well as through the online help system accessed
by pressing the help button.

To view the results of the analyses simply select the analysis type from the categorical list on the right and
it will be shown in the table on the left. You can copy and paste values from this table into your preferred
spreadsheet or statistical package using the edit menu, toolbar buttons or right click popup menu. You can
also save single tables by right clicking the required table in the results tree on the right. Certain tables may
also be saved in other formats. For example the popup menu for ‘Binary site summary’ will allow you to save
as a GIS Shapefile (see page 13 for more information).

To save all the analysis results at once, you can go to File » Save » Save analysis results or use the save
button on the toolbar. You have the option of specifying ZIP or XLSX format, the former will give you a ZIP
file containing each table as a CSV text file, the latter will give you a single Microsoft Excel workbook with
each table as a separate worksheet.

3.2 Tools

FHAES includes a number of tools for manipulating and processing your fire history data. These are available
from the buttons on the toolbar or from the ‘Tools’ menu on the main screen. Because of their complexity, the
§% Sample Size Analysis, . Superposed Epoch Analysis and # Chart tools are described in their own chapters
(chapters 6, 7 and 8 respectively). Descriptions and instructions for all other tools are provided below:

3.2.1 Merge selected files

2* The ‘'merge selected files' tool enables you to combine the data from two or more FHX files into a single file.
It maintains all the samples from each input file as separate series within the output file. Note that because
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the tool requires two or more files, it will only be enabled once you select two or more files from the file list.
When you launch the tool you will be asked whether to merge all years or just a subset of years. Once you
have made your choice you will then be asked where you'd like to save the resulting FHX file, and whether
you'd like to immediately add it to your existing project.

3.2.2 Create composite file

w The ‘create composite file' tool is similar to the merge tool, with the exception that all samples from a file
are combined into a single series in the output. The output file therefore contains the same number of series
as input files. Like the merge tool, a dialog will open asking whether the output file should be restricted to
specified years, or whether all years should be included. However, you will also be asked to specify how the
composite should be calculated. When creating a composite it is often desirable to ignore events that are not
widely represented in your datasets. The composite filter enables you to specify a threshold of absolute number
of events, or to specify a percentage of series which must share the event for it to be included.

Note that events in composite files are always recorded as having an unknown seasonality because FHX files
cannot represent events without multiple seasons within a single year.

3.2.3 Create event file

5 The ‘create event file’ tool produces a simple single column text file containing a list of years recording
events. The file is typically used as an input to Superposed Epoch Analysis (see chapter 7) but may also be of
use for other analyses. The tool is run on one or more selected files from the file list, and like the composite
tool, it also asks the user to specify a year range, and options for how to filter the input files into a composite.

3.2.4 Spatial join on selected files

@ The 'spatial join’ tool provides a method for creating event, composite and merge files based on location.
It is only available when two or more files are selected in the file list. The tool works by clustering together
files based upon the lat/long location fields provided in the FHX file header. It gives you the option to specify
a threshold in kilometres lower than which sites are combined together. This is useful when doing regional
analyses when you have multiple sites located close to each other recording similar fire histories. By combining
these together you can simply the comparison between these sites and those located further away.

When you specify your distance threshold, the tool will automatically create groups of sites list on the left of
the dialog. You can click on each in turn to examine which sites have been included in each group. Files with
no location information (or whose location information has not been successfully parsed) are located in a final
miscellaneous group. By double clicking on the group names you can rename them to suit your needs. The
tool also includes a separate map tab to show the spatial relationship between the groups. Each group is given
a unique color.

The other parameter that needs to be set before continuing is what sort of output file you'd like to create:
event; composite; or merge files. Once you've chosen your output file type and selected save you will be asked
to chosen an output folder location. The files will be named according to the names you gave each group.

3.2.5 Create site summary shapefile

# The ‘create site summary shapefile' tool enables you to save the results of the ‘binary site summary’ table
in Shapefile format for further visualization and analysis in GIS applications such as ArcGIS and QGIS. The
resulting shapefile is typically viewed inconjunction with a temporal GIS plugin such as the Time Slider facility
in ArcGIS or the Time Manager plugin to QGIS.

The export to shapefile dialog (figure 3.3) asks the user to provide an export filename, to specify the style of
attribute table to use and to select the years you'd like to include. There are two attribute table styles, which
you will find most convenient will depend on the GIS tool you are using.
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e Generate shapefile ONONES

Output filename: || Browse

Attribute table style: (U One marker per site with multiple year attributes

() Multiple markers per site, one for each year
Years to include: Available: Selected:

1759 A
1760

1761 =

1762
1763 fscin]
1764
1765

OK Cancel

Figure 3.3: The screenshot of the export to shapefile dialog.

The first creates a shapefile with just one map marker pin (row) per site but the associated attribute table
contains multiple fields, one for each year requested. Because the shapefile format only supports a limited
number of fields you can only include data for 255 years in your file. An example of the associated attribute
table as displayed by QGIS is shown on the left in figure 3.4.

I Attribute table - style1 : Features total: B, filtered: 8, selected: 0 ORORE /(o) Autribute table - style2 = Features total: 1816, Filtered: 1816, selected: 0 (v (=) (X

name A 1759 © 1761 ¢ 1762 © 1763 ¢ 1764 ¢ 1765 : 1766 name A year  value © @
o [c2025001 1 0 0 0 0 0 0 0 227 | ca045001 1981 0

1 |ca050001 - - -1 -1 - - -1 -1 233 | cald5001 1982 0 L]
5 | 2054001 E] E] A A B E] Bl A 224 | c2045001 1983 0
3 |ca070001 E] E] El El El E] El El 225 | 045001 1984 0
4 | 2077001 - - -1 -1 A - -1 -1 226 | 2045001 1985 -1
5 | ca083001 E] E] A A B E] E] A 227 | c050001 1759 1
§ | 2088001 K] K] Kl Kl Kl K] El Kl 228 | 2050001 1760 1
7 | c2090001 - - -1 -1 Bl - -1 -1 229 | calS0001 1761 1
239 | c2050001 1782 1

O s 2,:, (anOOOj 1752 | 3

i Show All Features , =) 13 show AllFeatures =

Figure 3.4: Examples of the attribute tables associated with the shapefiles exported by FHAES. On the left is the table
produced when the output style was set to ‘one marker per site with multiple year attributes’, whereas the right shows
the output style when set to ‘multiple markers per site, one for each year'.

The second style creates multiple map markers (rows) for each site, one for each requested year. So if you
select 200 years you will end up with a shapefile containing 200 markers in the same location for each site in
your dataset. The associated attribute table will have just two fields, one containing the year and the other
the data value. An illustration of this is shown on the right in figure 3.4. There are no hard coded limits to
the number of sites or years you can include using this style. However, if you do select a very large dataset you
may find that your GIS becomes sluggish. In this case you would be best to import your data into a spatial
database and ensure the relevant indexes have been configured.



Chapter 4

Data entry

4.1 Introduction to FHX (Fire History Exchange) data files

The FHX data format is the data standard used to archive fire-scar based fire history data in the International
Multiproxy Paleofire Database hosted by NOAA!. Although the file extensions are .fhx, they are actually text
files formatted specifically for storing fire history information. While we recommend using the data entry tool
in FHAES, with a good understanding of the format it is also possible to edit FHX files using standard text
editing software.

The information recorded with FHX files includes an optional (yet highly recommended) header for storing
metadata about the site and the samples, followed by the data (see figure 4.1 for an example data file). The
data include the sample identification code and information regarding the beginning and ending year, years when
the sample was and was not fire scar susceptible, and years when a fire scar or other indicator was recorded. The
sample data are not numeric as is typical in dendrochronological data files, they are categorical and describe the
status of each tree ring for the entire series. There are different characters for the beginning year depending on
whether the sample included the pith (the true inside year). There are also different characters for the last year
of the series, indicating whether the sample still had bark, or if it had bare wood that could potentially have
eroded. The position of a fire scar or other indicator in an annual ring relative to its earlywood or latewood
can be recorded. This provides evidence of wildfire season. A complete list of the characters used for recording
all these conditions is shown in table 4.1.

The data for each sample are arranged by column, with each row corresponding to a year—beginning with the
earliest year of any sample in the entire data set and ending with the latest year in the entire data set. This
may seem unusual, but the nature of the data drives it. Fire scar data series can be several centuries or even
millennia long. If the data format were reversed — that is, each year was represented by a column rather than
a row, then there could be many hundreds of columns in a file. Viewing and managing many columns of data
is far more unwieldy in most software compared to viewing and managing many rows of data.

Further information about the FHX file format can be found on the NOAA Paleoclimate website?

4.2 Fire History Recorder

The purpose of the data entry module (FHRecorder) in FHAES is to create and edit FHX files. Please note
that it is designed for editing standard data series files recording information about individual trees (as outlined
above) and not for the very similarly formatted ‘composite’ files (see section 3.2.2) that represent data for
multiple trees and/or sites. There should be no need for you to manually edit composite files and FHRecorder
will warn you of this.

When creating a file we strongly advise you to record the metadata as fully as possible. If all the information
is not available at first, fill out as much as possible and plan to obtain it and revise the file later. Because the

Ihttp://www.ncdc.noaa.gov/data-access/paleoclimatology-data/datasets/fire-history
’http://www.ncdc.noaa.gov/paleo/impd/tree_event_info.html


http://www.ncdc.noaa.gov/data-access/paleoclimatology-data/datasets/fire-history
http://www.ncdc.noaa.gov/paleo/impd/tree_event_info.html
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1| Name of site : Mesic mainland sites around Lake Duparquet
2| Site code : DMM
3| Collection date: Summer 1985 and 1986
4| Collectors : Y. Bergeron, J. Brisson, D. Lemieux, F. Tetrault
5| Crossdaters . Y. Bergeron, J. Brisson, D. Lemieux, F. Tetrault, B. Suran
6| Number samples : 45
7| Species name : Thuja occidentalis, Pinus banksiana, Pinus resinosa
8| Common name . Eastern white cedar, jack pine, red pine
9| Habitat type : Mesic shoreline
10 | Country : Canada
11 | State 1 Quebec
12| County : Abitibi-Temiscamingue

13| Park/Monument : L.Duparquet Research and Teaching Forest
14| National Forest:

15| Ranger district:

16 | Township

Header / Metadata
-
~

Range
18| Section d
19| Quarter section:
20 | UTM easting : 630000m
21 | UTM northing : 5370000m
22 | Latitude 1 48 28 N
23 | Longitude 7917 W
24 | Topographic map: Rouyn-Noranda (32 D) 1:250 000
25| Lowest elev : 270m
26 | Highest elev
27 | Slope
28 | Aspect

29 | Area sampled

30 | Substrate type : Till, sandy clay, and silty sand

31 | Begin comments BELOW this line:

32| Principal Investigator(s) Yves Bergeron, Jacques Brisson;
33| End comments ABOVE this line.

35 | FHX2 FORMAT

36| 1573 45 3

37 | 676382883011400066669996777758882299996366662
38 | 026305112911677733332224877642225564455055559
39 | 776076659523823145894561823989784518904367894

40
a1 e 1573
A2 1574
<>
P21 [ (AP {... (e 1818
202 I [ 1819
203 I [ 1820
284 . I [ 1821
205| ..... Ui, [P [P = U A [IIIE..... 1822
206 ..... PR [P AP I (L 1823
207 ... [FRRS SRR RN PR PR PR [ 1824
208| ..... [FERRRRRI Foole U, [EEET 1825
298| ..... oo, N O O (T 1826
30| ..... oo, [P 1 =0 1 (T 1827
e ..... [EERRRRRRY RN Y Y I ) PRRPRT [T 1828
302 ... [EERRRRRR PR Y Y I ) PRRRR [T 1829
303 ... [FERRRRRI PR Y Y I RS PRRRRT [T 1830
304/ ..... oo, Lo b [T 1831
T35 ... Lo, Y Y Y I RS PRRPR [ 1832
Sl3esf..... [ERRRRRRRY [ [ 1833
07| ... [FERRRRRI PR Y Y I S PRRRRT LI 1834
38| ... [FERRRRRI PR Y Y I S PRRPPT [T 1835
39| ..... [oooiennn, [P 1P 1= IR (T 1836
30| ... Lo, RN PY NN I RS PRRPRRY [T 1837
31| ... [EERRRRPRY RN PY NN Y PRRPRRY [T 1838
32| ... [FERRRRRI RN PN NN Y PRRPPTY [EEEE e 1839
33| ... [FERRRRRI RN Y N N I Y PRRPPTY [ 1840
34| ... Lo Lol [T 1841
35| ... Lo, RN PY NN ) PRRPRRY [T 1842
36| ... [EERRRRPR RN PN N N Y PRRPRTY [T 1843
A7 ... [FERRRRRI RN PN N N I Y PRRPRTY LT 1844
38| ... [EERRRRRI RN Y N N I S PRRPPRY [T 1845
38| ... oo, Lo b [IT11...{. 1846
320(..... [, [..El.TIIIEU]....... |I]||EEEE. 1847
321 ... [ERERRRRRY Foc BT [LTETTTTT. 1848
322} ...u] B Foo T [EPETTTTT. 1849
4

Figure 4.1: An example FHX data file with header/metadata at top followed by data section. Note the file has been
split and truncated (indicated by the line numbers on the left) to show the detail of the most interesting part of the file.
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Symbol

Described as

Interpreted as

Period or dot

Left curly bracket
Right curly bracket
Right bracket

Left bracket

Bar or Pipe

Can indicate two things:

Space holder in data matrix before sample starts or after sample ends
Dated tree rings if sample is not recording for some period (typically
before the first event in a series)

Beginning of sample's tree-ring series, if pith is not present

End of sample's tree-ring series, if no bark is present

Pith date of a sample; not always present

Bark date of a sample; not always present

Recorder year, starts the year after the first fire event

d Dormant season The injury occurred between after cambial growth ceased or before

it began; during the cambial “dormant” season

E.e Early earlywood The injury occurred during the first third of tree ring growth.

M,m Middle earlywood The injury occurred in the middle third of the tree ring growth.

L,l Late earlywood Cambium was injured late in earlywood development.

Aa Latewood The injury was apparent in the latest stage of cambial growth that
year.

U,u Undetermined The position of the injury either was not or could not be determined.

Table 4.1: Symbols that indicate the status of each tree ring in a sample series.

Brackets indicate beginning and

ending years but are different depending on whether the pith or bark are present. Upper case letters designate years
with fire scars, while lower case letters show years when indicators of fire other than scars—like resin ducts and growth
releases—were present. Periods (dots) are used to fill the years before the tree was first scarred, or during periods when
it is uncertain that the tree was recording fires (for example, a pocket of rot has obscured some rings).

original FHX metadata format did not provide a field to record UTM zone, if you have the UTM coordinates,
record the zone used in the comment field and fill out the latitude and longitude field. For strongly recommend
that you use the latitude and longitude fields as the primary means for recording locality information.

To create a new file you can click the - icon on the toolbar, or by going to File > New. If you'd like to edit
an existing file open it in FHAES as normal, then double click the entry in the file list, or select the file and
click the ' edit button on the toolbar. The main data entry screen has four tabs: data; metadata (see figure
4.2); summary; and graphs.

4.3 Metadata

The metadata tab provides a straightforward method for filling out the fields that make up the FHX header and
at the bottom of the tab is space to enter comments. Next to each field is a help tip button which gives you
a short description of the field and the sort of data you should be entering. This information is also provided
below:

Township, Range, Section, Quarter Section — Township, range, section and quarter section fields have
been used historically in the USA to record the locations using the Public Land Survey System. If used,
the township and range fields are required at a minimum, with the section and quarter section values
optionally used depending on the precision and size of area being defined. These fields are not used by
FHAES in spatial analysis, the latitude and longitude fields should be used instead.

Site name — Human readable name for the site. To be compatible with FHX2 this field should be no more
than 70 characters long.

Site code — Short code used to identify the site. By convention and for use in FHX2, this should be 3
characters long, but can be longer if you only intend to use the file in FHAES.

Collection date — Date or dates when the samples included in this file were collected. It is best to use the
ISO 8601 standard so that dates are recorded YYYY-MM-DD e.g. 2000-12-25.
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e Fire History Recorder - cadmm001b.fhx W & &

Data | Metadata | Summary | Graphs
Samples in the currently loaded file: Data contained within the sample: 666

o + X Sample Name: |666 | First Vear: 1790 [ (I Pith Last Year: 1984 |5 @ Bark
607 [1775-1985] &
727 [1898-1984] I 4= Add Event J I X Delete Event J
666 [1790-13984,

| ! Event Type | Event Season | Event Year |

330 [1573-1984]
256 [1801-1984] Fire Scar Early earlywood 1892 ]
807 [1907-1984] Fire Scar Early earlywood 1922
816 [1912-1984] Fire Scar Early earlywood 1962
815 [1938-1984]
329 [1698-1984]
095 [1824-1984]
112 [1760-1984] =
113 [1796-1984]
468 [1894-1984] =+ Consolidate J I ;‘ Auto Populate J I “4= Add Recording J I X Delete Recording J
072 [1850-1984]
073 [1832-1984] Recording Start Year | Recording End Year |
071 [1733-1984] 1892 1983 ]
634 [1833-1985]
635 [1882-1985]
638 [1695-1885]
639 [1779-1985] v
Sort samples: |Manually v 1

Save Close Discard changes

Figure 4.2: The main data entry dialog showing a file containing multiple series. The details of the selected series (666)
are shown on the right. We can see it contains fire scars in the early earlywood portion of the 1892, 1922 and 1962
rings.

Collector(s) name(s) — The name or names of those in the field that collected the samples represented in
this file.

Dater(s) name(s) — Name or names of those who provided the dendrochronological placement for these
samples.

Latin name(s) — Latin names of the trees from which these samples were taken. If more than one species is

included in this file separate them with commas and then provide further information in the comments
field.

Common name(s) — Common/vernacular names for the species in this file. As for latin names if more than
one species is included then separate with commas.

Habitat type — Habitat type at this site. Please use standardized naming systems applicable to the region
wherever possible.

Country — Country where this site is located.

State — State where this sample is located.

County — County where this sample is located.

Park — Park (e.g. National Park) where this site is located.
Forest — Name of forest where this site is located.

Ranger district — The Ranger district that covers this site.

UTM easting —Warning Deprecated — UTM easting value for the site. The FHX specification does not provide
a facility for recording the UTM zone so UTM data is ignored by FHAES. The latitude and longitude
fields should be used instead.

UTM northing —Warning Deprecated — UTM northing value for the site. The FHX specification does not
provide a facility for recording the UTM zone so UTM data is ignored by FHAES. The latitude and
longitude fields should be used instead.
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Latitude — Latitude value for the location of this site. Although this is a free text field and any formatting
is valid, we strongly recommend using decimal degrees. Existing free text values can be parsed and
converted using the convert button.

Longitude — Longitude value for the location of this site. Although this is a free text field and any formatting
is valid, we strongly recommend using decimal degrees. Existing free text values can be parsed and
converted using the convert button.

Topographic map — Reference to the topographic map covering the site.

Highest elevation — Highest elevation of the site. Please also specify units.

Lowest elevation — Lowest elevation of the site. Please also specify units.

Slope angle — Angle of the slope of the site either as a description, or as a value in degrees.
Slope aspect — General aspect of the site, typically recorded as compass direction.

Area sampled — Total area sampled. Please also specify units. Should be 10 characters or less to remain
compatible with FHX2.

Substrate — Description of the substrate at this site.

Sample count — This field is automatically set by FHAES depending on the number of samples entered in
the data screen.

Note that all fields are free-text with no formatting restrictions (see section 4.7) but it is best to be consistent
and standardize wherever possible . For example, we strongly suggest for the latitude and longitude fields you
restrict yourself to using standard WGS84 decimal degrees. If you do have coordinates in other styles you may
like to try the conversion buttons to standardize your data. It will successfully convert many commonly used
styles of coordinates those in degrees, minutes and seconds.

The metadata tab includes a checkbox to enforce original FHX2 field length requirements. The original FHX2
program included limits for the length of each field. Although FHAES does not have these same limitations
(see section 4.6), if you intend to use the file in FHX2 as well as FHAES you should tick the checkbox here.
Fields that do not meet the FHX2 specification are highlighted in red and a warning appears at the top of the
screen. Note this checkbox enforces a length limit on sample names too.

4.4 Data

The main data tab is where you enter details about your samples and events. The panel on the left shows a list
of series within the file. Series can be added and removed using the plus and cross buttons respectively. The
order of the series can also be changed, either automatically by choosing sort criteria, or manually by using the
up and down buttons. The order of the series in this list will be reflected in the order they appear in the FHX
file, and therefore the order they will appear in analysis outputs and charts.

When you add a new series, you will be asked: to give the series a name; to specify the start and end years for
the sequence; and to indicate whether the sample has pith and/or bark (see section 4.7 for an explanation of
cases where pith/bark information is disregarded). In FHAES, the series name can be as long as the user wishes
unless the ‘Force FHX2 requirements’ checkbox has been selected on the metadata page. In this case you will
be restricted to eight characters to ensure the file can be successfully read in the original FHX2 program. See
section 4.6 for more information.

4.4.1 Events

To add events to the series, first select the sample in the list. The panels on the right will show the details
about the selected series and list any existing events currently associated with it. The series name, year range,
pith and bark information are displayed and can be edited at the top of the screen. You can add events by
clicking the add event button. In the event table you can then specify: whether the event is a fire or other
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injury; the year the event was recorded and what season it was recorded in. Note that events will automatically
be ordered into chronological sequence.

Once the recording years table (described below) has been populated also note that you will not be able to add
events that fall outside of the year range(s) that describe when the tree was ‘recording’. For instance if you
need to add an event prior to your first defined event you will need to extend the recording years backwards in
time before the event table will accept the earlier year.

4.4.2 Recorder years

Once you have entered the events for your sample, you can then specify the recorder years i.e. the years in
which the tree was susceptible to fire (sensu Romme, 1980). Typically this will be from the first event until
the end of the sample. If the recording years are not correct you can automatically re-populate the table using
the button above the table. This option allows you to override the recording years to: from first event to the
end of the sample; or from beginning to the end of the sample. The second case is used occasionally by some
researchers when working with certain ecosystems and species where it has been determined that trees record
fires regardless of whether they have already sustained an injury or not. [clarification and citation required]

In some samples there may be periods when the sample reverts to ‘non-recording’ status in the middle of the
series. For instance a tree that has been injured by fire and therefore considered to be in ‘recording’ status may
grow over and around the scar until it is completely covered. At this point the tree would be considered to be
in ‘non-recording’ status again until another cambium-damaging fire was to occur. In such cases you can add
multiple ranges for ‘recording’ with gaps covering the ‘non-recording’ years to reflect this.

4.5 Summary and Graphs

The remaining two tabs in the FHRecorder window provide an overview of the data file which can be helpful to
verify that the data entry has been done correctly. The summary tab (figure 4.3) provides a table summarising
the samples on a year-by-year basis. For each year the number of events, the number of samples and the
percentage scarred samples are shown, along with the distribution of events by season. The final column of
the table includes a colour bar summarising the seasonality of the events recorded. The colour bar can be
customised with the button at the top of the screen. This enables the user to change colours as well as merge
together seasons into a single colour bar. This is done by dragging and dropping the seasons together into a
single group.

The summary table can be exported to a CSV file using the relevant button at the top of the screen. It can
also be copy and pasted into various spreadsheet applications.

The graph tab (figure 4.4) shows similar information in a graphical form. The colour bar is replicated horizontally
at the top of the screen, with the number of events and samples shown at the bottom. One good use for the
bottom graph is to check for single events located immediately before or after a large number of events. This
may be an indication that an event has been added a year too early or late.

4.6 FHX2 restrictions

The original FHX2 application enforces a number of limitations on field sizes and amount of data. This
was in response to the relatively limited computer resources available at the time the program was originally
written. With the ever increasing speed and amounts of memory in modern computers such limitations were
not necessary when developing FHAES. FHAES can therefore read and edit all data files produced by the
original FHX2 application, however, a little care must be taken if you intend to use files created by FHAES in
FHX2.

On the metadata page of FHRecorder there is a checkbox that instructs FHAES to enforce the original FHX2
format requirements. With this checked, the FHX2 field length limits are displayed and any fields exceeding
these limits highlighted. Any fields not meeting the restrictions must be truncated before the file can be saved.
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& Fire History Recorder - cadmmO001b.fhx ™)

6
&

Data | Metadata | Summary | Graphs

[ =) Export summary ] { K Customize J
Year Events | Total Samples % Scarred |D E M L |A |u | Color Bar |
1938 0 44 0% 0 0 0 0 0 0 [ a
1939 0 44 0% 0 0 0 0 0 0 r
1940 3 45 7.69% 0 2 0 0 0 1 |
1941 1 45 2.56% 0 0 0 0 1 0 ]
1942 1 45 2.56% 0 1 0 0 0 0 s
1943 o 45 0% 0 0 o o o o
1944 1 45 2.56% 0 1 0 0 0 0 .
1945 2 45 5% 0 2 0 0 0 0 ]
1946 0 45 0% 0 0 0 0 0 0
1947 1 45 2.5% 0 0 0 0 0 1
1948 0 45 0% 0 0 0 0 0 0
1949 0 45 0% 0 0 0 0 0 0
1950 o 45 0% 0 0 o o o o
1951 0 45 0% 0 0 0 0 0 0
1952 1 45 2.44% 0 1 0 0 0 0 .
1953 0 45 0% 0 0 0 0 0 0
1954 1 45 2.44% 0 0 0 0 0 1
1955 0 45 0% 0 0 0 0 0 0
1956 1 45 2.44% 0 1 0 0 0 0 ]
1957 o 45 0% 0 0 o o o o
1958 0 45 0% 0 0 0 0 0 0
1959 0 45 0% 0 0 0 0 0 0 v

Save Close Discard changes

Figure 4.3: The FHRecorder summary tab summarises the information recorded in a data file on a year-by-year basis.

o Fire History Recorder - cadmm001b.fhx &
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Data | Metadata | Summary | Graphs
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Save Close [ Discard changes

Figure 4.4: The FHRecorder graph tab illustrates similar information to that provided in the summary table (see figure
4.3) but in a graphical form.
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Additional limitations in FHX2 that are not present in FHAES include: the length of series names (limited to
8 characters); the number of series in a file (up to 254); and range of years (501BC-2020AD although earlier
releases were 501BC-2006AD). It is also worth noting the difference in handling of BC dates in FHAES and
FHX2. FHX2 uses the astronomical dating system which includes the year zero. This means that all year
numbers prior to 1AD are offset by one e.g. 1AD=1; 1BC=0; 2BC=1 etc. FHAES on the other hand uses
Gregorian year numbering, thus skipping the non-existent year 0. Care should therefore be taken when moving
datasets containing BC data between the two programs.

4.7 Limitations of the FHX format

Even though the field and data length restrictions of FHX2 outlined in section 4.6 have been removed in
FHAES, the FHX format still has a number of fundamental limitations for the accurate description of fire
history data. The primary issues are outlined below:

» No standardisation of metadata — The metadata fields that are present in FHX files are all free text
with no restrictions on how information should be added or formatted. The clearest example of this is
the latitude and longitude fields. They can be written in a wide number of formats and styles: either
decimal degrees; degrees minutes and seconds; degrees and decimal minutes; direction characters variably
as +,-,N,S,E or W; space delimited; apostrophe delimited. The list is almost endless. To make use of
this information in FHAES or in any other software, the coordinates, and other metadata fields must be
interpretable without manual user intervention.

» Single data point per sample per year — The format only allows for a single data point to be recorded
for each sample in each year. This causes problems, for instance when a tree begins or ends with an
event as it means the pith/bark status cannot also be included®. Perhaps more importantly, it means
that fire scars and other injuries cannot be coded in the same years which provides significant problems
for those attempting to do analysis comparing say fire and insect outbreaks in the same stand.

» Metadata applies to all series in the file — The metadata header is limited by the fact that it applies
to all series within the file. If the file contains data from different species, although the user can list the
species in the header, there is no mechanism for defining which species applies to which series. There is
a similar issue with coordinates as it's routine now to record each tree location with a GPS rather than
more general coordinates for entire sites. Likewise for slope, aspect, collection date, substrate type etc,
users may prefer to record these on a tree-by-tree rather than site-by-site basis. Having access to this
data would be extremely useful especially for charting purposes.

» Pre-defined categories of events with no flexibility — The analytical routines within FHAES are
agnostic with regards the type of events being processed. However, the pre-defined nature of the event
categories defined in the FHX format means that users may have difficulties in adapting their data when
using FHAES for novel analyses. As indicated elsewhere in this manual, the analyses performed in FHAES
are not limited to fire histories but could be used for a wide variety of similar event types. These pre-
defined event categories also do not allow for the recording of more general (textual) observations about
particular rings.

» Separation of dendro and fire history data — Fire history research is often conducted alongside
traditional dendrochronological research. The separation of ring-width and fire event data into different
data files means duplicatation of effort with regards metadata management. Combining all this data into
a single file would be more efficient and would also facilitate analyses that combine ring-width and event
data, for instance growth releases following fire events.

» Dated and undated series — Although fire history research is conducted overwhelmingly on trees that
are absolutely dated via standard dendrochronological methods, it is conceivable that researchers may
want to use FHAES on samples for which this is not the case. For example research may be carried
out on wood sourced from archaeological or palaeoecological contexts. In these cases the samples may
be dated within a relative dating framework; dated with uncertainty (e.g. via radiocarbon analysis); or
not-dated at all. It would be preferable if this information was included alongside the fire history data.

3In cases like this the event information supersedes the pith/bark status so data series may in some circumstances begin and/or
end with events rather than brackets. When this happens we must assume pith and/or bark are absent.
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To overcome these issues, the long-term aim is to support the Tree Ring Data Standard (TRiDaS — Jansma
et al., 2010) within FHAES while maintaining the ability to read existing FHX data files. In the mean time we
recommend you maintain extensive notes to go with your FHX files. These can then be used to upgrade your
existing FHX files in future once TRiDaS is fully supported.






Chapter 5

Analyses

5.1 Interval analysis

The Interval analysis tables shows the results of a variety of analyses for each data file. A description and
formula for each is shown below.

5.1.1 Coefficient of Variation
5.1.2 Skewness

5.1.3 Kurtosis

_ —6I'{ 4+ 1237y — 313 — 4l T3 + Ty

= [Ty — T3 G
where: T'; =T'(1 + £)
5.1.4 Weibull Scale Parameter
Ae(0, 00) (5.2)
5.1.5 Weibull Shape Parameter
ke(0, 00) (5.3)
5.1.6 Weibull Mean
AP+ 1) (5.4)
5.1.7 Weibull Median
A(In(2))* (5.5)

5.1.8 Weibull Modal

{ 3(%)E k i 1 (5.6)
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5.1.9 Weibull Standard Deviation
5.1.10 Weibull Fire Frequency

5.1.11 Weibull Skewness

I(14 2)A% = 3uo? —

(5.7)

5.1.12 Exceedance Intervals

5.2 Seasonality

5.3 Binary summary matrices

The binary summary matrices provide summaries of presence or absence of events, be they fire, other injuries,
or both. If an event is recorded then the matrix includes a value of 1, whereas if the event is not recorded
despite the fact the trees were capable of recording then the matrix includes a value of 0. If there is no data
for that particular year (perhaps the tree-ring record doesn't extend to that particular year) then a value of -1
is recorded in the matrix.

There are three types of binary summary matrices produced by FHAES:

Binary site summary — this provides a summary on a site-by-site basis, therefore the matrix has one column
per file.

Binary tree summary — this provides a similar summary but divided into individual trees. In addition to the
normal header row containing the site name, code or filename, the matrix has a second header row
containing the tree code.

NTP matrix — the NTP matrix contains three columns per file: one for the number of fires; one for the
number of trees; and a third for the percentage of trees that were scarred.

5.4 Binary comparison matrices

5.5 Similarity and dissimilarity matrices
The general form for a probability-corrected similarity index is:

Where Sp is the pth index, P(z) is the probability of agreement between two pairs, and P(e) is the expected
probability of agreement based on chance.

Site j
Outcomes 1 0
Site i 1 a(1,1) b(1,0)
0 c(0,1) d(0,0)
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This method can be illustrated with Cohen's index (Scon). in which both (1,1) and (0,0) cases a and d are
considered ‘agreement’, P(a) = %2, where N = a+ b+ c+ d. P(e) is computed as the joint probability of
sites i and j having a ‘1’; hence,

a+b

P(1i) =~ (5.9)
P(1j) = 22¢ (5.10)
P(e) = P(1i) x P(1j) (5.11)

Consider a comparison between a pair of sampling units with the following outcome:

Outcomes 1 0
Site i 1 8 (1,

Hence a =8, b=4, c =5, d =83, and N = 100. Then:

8+ 83

P(z) = ——— =0.92

(2) 100 0.920
8+4

P(1i) = 71—50 =0.120
845

P(e) = 0.12 x 0.13 = 0.016

0.920 — 0.016
Scon = —— 22— 0.919
con 1-0.016

Note that similarity in this case is dominated by the d (0,0) case. This represents a common outcome for rare
events where d >> a.

In the previous example, when both the a and d cases are considered ‘agreement’, the index can be dominated
by d case when events (a) are rare. An alternative approach for rare events is to calculate similarity based
on the positive outcomes only, e.g. in our context, event years, the a (1,1), b(1,0), and c (0,1) cases. Let
R = (a+ b+ c¢), the union of event years; then pairwise similarity is calculated as:

P(a) — P(ex)

Sp = 1 — P(ex)

(5.12)

Where P(a) = %, the probability of the a case given a fire in either site, P(1x;) = %2, P(1x;) = %<, and
P(ex) = P(1%;) x P(1x;), the probability of joint 1s occurring by chance in an event year. In the example
given:

L=a+b+c=8+4+5=17

8
P(a) = 3= = 0471

8+ 4
P(1%) = % — 0.706
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845

V=212 0765
P(1x;) T
P(e) = 0.706 x 0.765 = 0.540
0.471 — 0.540
sl T
S = 0540

This index reflects only the distribution of the event cases a, b, and c. The outcome is negative if (b+¢) > a,
and positive if a > (b+¢), which complicates interpretation. To avoid this outcome the index can be expressed
as 1+ .5, which occurs on 0,1; in this case, Sx = 0.85.



Chapter 6

Sample Size Analysis

6.1 Introduction

Like all areas of paleoecological research, fire history relies on analysis of remnant evidence. While such evidence
can provide a long time perspective on ecological processes, individual remnant evidence generally represents
an incomplete picture of the events and conditions at the time of its creation. In the case of fire history, fire
scar formation and retention reflect a combination of deterministic and stochastic processes. Fire does not
cause the cambial damage that leads to lesion formation in every tree in a stand exposed to fire; fire intensity
(heat output per unit area) can be highly variable within stands due to variation in fuel mass and continuity,
as well as fine-scale variation in winds, humidity, and topography. Tree characteristics (such as diameter, bark
thickness and rooting depth) can also vary within stands, making some trees more susceptible to scarring than
others. Once scarred, a variety of contingent factors affect the retention and preservation of lesions, including
subsequent burning, mechanical damage, wood decomposition, and mobilization of resin into xylem cells in a
zone from the heartwood to the injured surface. The net result of these factors is that individual trees provide
an incomplete record of fire occurrence, even at the stand scale.

To counteract the limitations of records provided by individual trees, fire historians and ecologists typically
create composite records comprised of the recorded fires from multiple trees in a stand or other scale of
interest. In most fire regimes, the records from individual trees overlap to some extent; i.e., there are some
fires in common between trees, whereas other events may be detected on some trees but not others. Thus,
as the number of trees sampled increases, additional fire dates are usually detected, but at a decreasing rate
(Falk, 2004). This pattern is formally analogous to the “collector’s curve” in estimating species richness from
a number of sample plots. For a given area, the number of species detected (s) is a function of the number
of samples (trees or plots). As n increases, s generally increases at a decreasing rate, causing the collector's
curve to flatten out with additional samples.

The sample size analysis tool is designed to ask the same question for characterization of fire history in a study
area. Have we sampled enough trees to capture the main fire dates, and to characterize properties of the fire
regime (frequency, interval distribution, etc.)? If our sample size is too small, can we estimate how many more
samples would be required to provide a reliable estimate of the site fire history?

Although sample size analysis tool is designed to explore the effect of sample size on the observation of fire
frequency, it is equally capable of exploring other event data such as insect infestations. The tool calculates
the mean number of events per century observed in an ever decreasing sub-sample of series within a data file.
Multiple simulations are run by randomly picking series from the file to simulate the reduction in tree sample
size.

The sample size analysis tool in FHAES is a reimplementation of the original SSIZ tool written by Richard
Holmes under the direction of Tom Swetnam at the Laboratory of Tree Ring Research, University of Arizona.
The FHAES implementation of SSIZ removes the limitations in simulation number, sample size, and time span
imposed by the original SSIZ program while dramatically speeding up analyses. FHAES also extends the the
original SSIZ analysis to include the calculation of asymptotes as described by Falk (2004). This provides an
indication of the number of samples required in a particular study region to ensure the fire history regime has
been accurately characterised.
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Figure 6.1: The screenshot of the sample size analysis tool. The screen includes the analysis parameters on the left and
the results on the right.

6.2 Performing analysis

The sample size analysis tool is launched from the tools menu or via the equivalent button on the FHAES
toolbar. The screen (figure 6.1) is split into two halves: the left containing the analysis parameters; and the
right the analysis results. The parameters required by the tool are outlined below:

Input file — provide an FHX format file containing the data you would like to analyse. If you would like to
analyse data across multiple files you will need to use the ‘Merge files' tool in FHAES first (see page 12).

Event type — you can choose to analyse: just fire events (in which case all lower case events are ignored in the
FHX data file); just injuries (in which case upper case events are ignored); or fires and injuries together.

Simulations — here you specify the number of simulations or repetitions on the analysis you'd like to run for
each stage of the analysis. The more simulations you run the small the confidence intervals, however the
longer the analysis will take.

Seed number — the random selection of series is in fact pseudo-random. This means that when an analysis
is done with the sample parameters and seed number the results will be identical’. The seed number
should be a large integer and can be left as the default value unless you specifically want to generate
results from a different randomised pool of series.

Resampling — FHAES supports resample both with and without replacement. When sample with replacement
is chosen, each random selection of a series is done from the entire dataset which means that one series
can be included multiple times. Conversely when sampling without replacement, each series can only
appear in the random pool once.

Threshold — the threshold parameters determine how many times an event must be recorded in the file to be
considered a true event for sample size analysis. The threshold can be determined either as an absolute
number, or as a percentage within the dataset. If the threshold is set to j1 fire then all events within
the dataset are used including those that are only represented by a single series. Often researchers prefer
to exclude events recorded by just one tree as they can be indicative of very localised fires that have not
played a significant role in the region.

IThis should be the case when run on different computers running the same major version number of Java, however it can only
be guaranteed when run on exactly the same system.
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Common years — this option enables users to limit the analysis to only the years in common to all series
within the file. This can be useful, for example, when a single series in the file extends way beyond the
temporal coverage of all the remaining series in the file. If all years are considered in such an analysis,
then the events recorded by the long series will skew the analysis.

Include series with no events — this option enables the user to choose whether to include or exclude series
which don’t include events. By excluding series with no events the user should interpret the result of
the asymptote analysis as indicating the number of samples with evidence of fires required to adequately
characterise the fire history of the study region. If series are included, then the asymptote is indicative
of the number of trees required to characterise the regime of the study region, regardless of whether the
trees have any visible signs of fire damage. This could be useful for instance if you are studying insect
oubreaks where trees are sampled without any visible damage. Note that if you are running analyses on
a subset of a series (either due to the common years option being enabled, or through segmentation)
then a series will be excluded if there are no events within the time period being analysed, regardless of
whether it has events elsewhere in the dataset.

Segmentation — the segmentation parameters enable you to run the sample size analysis on one or more
time periods in the file. You can manually specify the start and end years for each segment by click the
‘add’ button and typing the values in the table. Alternatively you can use the ‘auto populate’ button to
generate equally sized segments. The dialog asked you for the first year you'd like analysed, the length
of each segment and the lag between the start of each segment. For instance with a start year of 1600,
a length of 100 and a lag of 50, the segments would run: 1600-1699; 1650-1749; 1700-1799 etc.

Once you have entered your parameters you can press the ‘run analysis’ button at the bottom of the screen or
on the toolbar. Note that if you have chosen a very large number of simulations and have many series in your
data file, the analysis may take several minutes to run.

6.3 Analysis results

The results of the analysis are shown in the tables and graph on the right hand side of the screen.

The options on the chart enable you to visualise the the different measures calculated during the analysis. If
you ran the analysis on multiple segments you can choose which segment to view. The shaded area on the
chart shows the confidence interval. This chart can be exported to in both PNG and PDF formats by right
clicking and it can also be copied and pasted into other applications. Some basic properties of the chart can
be altered through the right click properties option.

Once you have run your analysis you may prefer to hide the parameters panel by clicking the
collapse button on the vertical divider in the middle of the screen. Likewise the amount of space
given to the chart and tables can be altered by dragging the horizontal divider.

Below the chart, the raw data produced by the analysis are shown in tables. These tables can be copy and
pasted into other applications such as spreadsheet programs for further analysis. They can also be exported to
tab delimited text files. Both options are accessed via a right click menu. Alternatively you can use the option
in the file menu or the equivalent button on the toolbar to save the results to disk.

6.4 Interpreting results
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Function Family pdf Asymptotic term
Logistic Sigmoidal a a
ISTI 1Igmol —_——
& & 1+ be—c=
: : . ar
Michaelis-Menten Growth /saturation a
b+zx
Modified exponential Exponential aer a
. . . b d
Modified Michaelis-Menten  Growth /saturation avter c
b+ xd
Weibull Sigmoidal a — be—e" a

Table 6.1: Description of the different curve fitting functions used to calculate the asymptote.
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Superposed Epoch Analysis






Chapter 8

Fire History Charts

FHAES includes the tools necessary to produce publication quality fire history charts. These charts provide a
powerful method for illustrasting the fire regime of a site or region.

To produce a chart, simply select the file of interest in your file list on the left panel in FHAES, then either
click the chart button on the toolbar, select View » Fire History Chart, or right click and select ‘Fire history
chart’ from the popup menu. Figure 8.1 shows a typical chart produced by FHAES.
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Figure 8.1: A typical fire history chart produced by FHAES. The chart has three optional components: fire index plot
(top); fire chronology plot (middle); and fire composite plot (bottom).
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A\ Please note that in this release of FHAES the chart module only supports the plotting of standard
FHX files with series that begin and end with bracket characters. If you try to plot composite files,
or files which begin or end with an event,

8.1 Chart components

There are three components to a fire history chart, each or which can be included or removed as desired. The
first (shown at the top of figure 8.1) is the fire index plot. This includes a histogram showing the sample
depth for each year (i.e. how many trees are recording the fire history in each year) and a bar chart illustrating
what percentage of these trees record a scar event.

The second component is the fire chronology plot. This shows a bar for each sample in the file illustrating
the timeline for the tree e.g. the start and end year for each sample and all fire events. Through the use of
various symbols the plot illustrates whether the tree is recording fire histories or not; when a tree records a
fire scar or injury; and whether the sample starts and ends with pith and bark or not. Figure 8.2 shows the
symbols used by this plot for each feature.

The third and final component is the fire composite plot. This shows whether the samples in the site or
region as a whole record a fire event depending on certain threshold criteria set in the plot preferences. When
the criteria are met, a line is marked on the plot for that year. The criteria can be set so that only years
where greater than a specified percentage of trees record an event are marked. It is also possible to require a
minimum number of samples so that events recorded by small number of trees when the sample depth is very
low are not shown. These criteria are set by going to Edit » Filter Options » Composite Axis Filters.

Recorder year

..... Non recorder year

Fire event

Injury event

-| Inner year with pith

Inner year without pith
Quter year with bark

QOuter year without bark

H4EIINE:

Figure 8.2: Legend for fire chronology plots.

Each of the chart components can be displayed or hidden by toggling them on and off using the toolbar buttons
or the options in the view menu.

8.2 Maodifying the chart

The main features of the chart can be altered through the chart properties dialog. This can be access through
the toolbar, menu or by right-click popup menu. Options such as fonts, colors, ticks, grids, titles, labels etc
can all be altered here.

It is possible to restrict the temporal scope of the chart to a certain year range by clicking and dragging on
the chart. To return the chart to the full extent, simply click the ‘zoom to full extent' button on the toolbar.
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The contents of the chart (i.e. exactly what is plotted) can be altered in a couple of ways. First through the
use of the Edit > Filter Options » Select Series to be Plotted menu. Here you can choose to hide one or more
series from the file and you can also alter the order that they appear in the fire chronology plot. The contents
of the composite plot can be altered using the Edit > Filter Options » Composite axis filters dialog. This
works in a similar way as the composite filter dialogs elsewhere in FHAES whereby a threshold of number or
percentage of samples recording an event can be specified.

8.3 Exporting charts

Once you are happy with your chart you have two options for exporting it for use in publications and reports.
The chart can either be saved as a PNG image or as a PDF file. Both of these options can be accessed through
the toolbar or the file menu. Which format you choose depends on how you will use the chart. The PNG image
file can easily be embedded in word processing documents but because it is a raster file format the quality of
the output will degrade if enlarged too much. The PDF format is written as a vector file so can be enlarged
to any size with no loss in quality. The PDF format should therefore be used when publication quality output
is required.
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Chapter 9

Developing FHAES

FHAES is open source software and we actively encourage collaboration and assistance from others in the
community. There is always lots to do, even for people with little or no programming experience. Please get
in touch with the development team as we'd love to hear from you.

0.1 Source code

This section describes how to access the FHAES source code, but as you are no doubt aware it is normal (if
not essential) to use a integrated development environment for developing any more than the most simplistic
applications. If you plan to do any development work, it is probably best to skip this section and move straight
on to the ‘Development environment’ section which includes instructions for accessing the source code directly
from your IDE. If, however, you just want to browse the source code please continue reading.

The FHAES source code is maintained in a Subversion repository at Sourceforge.net. The simplest way to
see the source code is via the web viewer on the Sourceforge website: http://sourceforge.net/p/fhaes/
code/HEAD/tree/trunk/.

If you have Subversion installed you can do an anonymous checkout of the code as follows:
svn checkout svn://svn.code.sf.net/p/fhaes/code/ fhaes-code

An overview of the development can be seen through the FHAES Open Hub pages at https://www.openhub.
net/p/fhaes/. Open Hub provides graphics summarizing the code over time, including timelines of commits
by user.

9.2 Development environment

The IDE of choice of the main FHAES developers is Eclipse (http://www.eclipse.org). There are many
other IDEs around and there is no reason you can't use them instead. Either way, the following instructions
will hopefully be of use.

We have successfully developed FHAES on Mac, Windows and Linux computers. The methods for setting up
are almost identical.

The first step is to install Eclipse, Java 6 or 7 JDK, Subversion, Maven, RPM and NSIS®. These are all readily
available from their respective websites. On Ubuntu they can be install from the command line easily as follows:

sudo apt-get install eclipse subversion default-jdk maven2 nsis rpm

L1f you do not have NSIS and/or RPM installed you will get an error when packaging FHAES, however, all other aspects of the
development environment should work fine if you comment out the NSIS and/or RPM sections in the pom.xml file. Remember
not to commit this change to the repository though!


http://sourceforge.net/p/fhaes/code/HEAD/tree/trunk/
http://sourceforge.net/p/fhaes/code/HEAD/tree/trunk/
https://www.openhub.net/p/fhaes/
https://www.openhub.net/p/fhaes/
http://www.eclipse.org
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Once installed, you can then launch Eclipse. To access the FHAES source code you will need to install the
Subversive plugin to Eclipse. As of Eclipse v3.5 this can be done by going to Help > Install new software.
Select the main Update site in the ‘Work with’ box, then locate the 'Subversive SVN Team Provider' plugin
under ‘Collaboration’. If you are using an earlier version of Eclipse you may need to add a specific Subversive
update site. See the Subversive website (http://www.eclipse.org/subversive/) for more details. Once
installed you will need to restart Eclipse.

Next you will need to install the m2e Maven plugin to Eclipse. This can also be installed by going to Help
- Install new software, however, you may need to add the Maven update site as this plugin is not currently
available in the main Eclipse repository. You can do this by click the ‘Add’ button and using the URL http:
//m2eclipse.sonatype.org/sites/m2e. Once again you will need to restart Eclipse before continuing.

Next you need to get the FHAES source code. Go to File New » Project, then in the dialog select SVN »
Project from SVN. There are two methods of accessing the FHAES repository: anonymously (in which case
you will have read only access); or with a username provided by the FHAES development team. Anonymous
users will need to add a repository in the form: http://svn.code.sf.net/p/fhaes/code/ and full users
will need to use svn+ssh://svn.code.sf.net/p/fhaes/code/.

FHAES is comprised of a number of projects which are stored as seperate folders within the ‘trunk’ folder in
in Sourceforge. This enables us to work and package different aspects of the system separately. For instance
the graphics module can be built and run separately from the main stats modules. You will need to set up
separate projects in Eclipse for each of these modules:

» FHULIl

» FHRecorder
» FHChart

» FHSampleSize
» FHAES

The FHAES project is the main application that most users use to access the functionality of the other modules.
Although FHAES depends upon the other modules mentioned above, the Maven configuration should retrieve
these modules from our Maven repository if you don't intend to work with them. This means you shouldn’t
need to configure all modules in Eclipse to get up and running.

To launch FHAES from within Eclipse you will need to go to Run » Run Java application. Create a new run
configuration with the main class set to ‘org.fhaes.gui.MainWindow'.

9.3 Dependencies

FHAES is built with Maven. One of the main benefits of Maven is that it handles dependencies efficiently.
All the libraries that FHAES relies upon are configured within the Maven pom.xml file and installed seamlessly
as part of the build process. Maven handles transient dependencies (i.e. dependencies of dependencies) auto-
matically. Therefore if a developer knows he needs the functions within a particular library, he simply needs
to supply the details of this library without having to worry about the other libraries that this new library is in
turn dependent on. Maven also manages versions efficiently. If a library is dependent on a particular version
of another library this is specified within the Maven build mechanism. This means it is much easier to keep
dependencies up-to-date without having to worry about the cascading issues that upgrades often have. In
short, Maven is intended to save developers from ‘JAR hell'.

For the record, FHAES currently depends upon the libraries listed in table 9.1. The table also specifies the
licenses that these libraries are made available under.


http://www.eclipse.org/subversive/
http://m2eclipse.sonatype.org/sites/m2e
http://m2eclipse.sonatype.org/sites/m2e
http://svn.code.sf.net/p/fhaes/code/
svn+ssh://svn.code.sf.net/p/fhaes/code/
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Library License

Apache commons lang  Apache 2.0

TridasJLib Apache 2.0
JFreeChart LGPL
JMapViewer GPL

Log4J Apache 2.0
iText GAPL
DendroFilelO Apache 2.0
Java Simple MVC MIT
SLF4J MIT
MiglLayout BSD
SwingX LGPL

Table 9.1: FHAES primary and major first order dependencies along
with the licenses under which they are used.

Library License

Apache commons lang  Apache 2.0

Launch4J BSD/MIT
NSIS zlib/libpng
Ant Apache 2.0
Eclipse Eclipse Public License - v1.0
M2Eclipse Eclipse Public License - v1.0
Subversive Eclipse Public License - v1.0

Table 9.2: Additional tools/libraries typically used in the development
of FHAES.

9.4 Multimedia resources

FHAES includes infrastructure for multimedia resources such as icons and images within the Maven resource
folder ‘src/main/resources’ of the FHUtil module. The icons are accessed via the static Builder class. This has
various accessor functions which take the filename and return the icon itself or a URI of the icon from within
the Jar.

9.5 Logging

Logging in FHAES is handled by the SLF4J and Log4J packages. Rather than write debug notes directly to
System.out, Log4J handles logging in a more intelligent way. First of all, each log message is assigned a log
level which are (in order of severity) fatal, error, warn, info, debug and trace. Through a log4j.xml configuration
file contained within the FHULtil resources folder, we can control the level at which messages are displayed. For
instance while we develop we would likely show all messages up to and including ‘trace’, but when we deploy
we might only want to show messages up to and including ‘warn’.

Log4J also enables us to log to several places (known as appenders), e.g. console, log file or a component
within our application. It is also possible to change the level of logging depending on the log type, so minimal
messages can be sent to the console but verbose messages to the log file. FHAES has the following appenders
configured:

» Standard log file (fhaes.log) that rolls over up to 2mb of messages
» Console — standard messages to the console when launched from command line

» Help console — simple console component available from the FHAES application menu Help » Error log
viewer
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To alter the way these appenders are configured you need to edit the log4j.xml file. See the Log4J documen-
tation for further information.

Using the logging framework is very simple. Just define a Logger as a static variable in your class like this:
private final static Logger log = LoggerFactory.getLogger (MyClass.class);

where MyClass is the name of the current class. Then you can log messages simply by calling log.warn(‘My
message'), log.debug('My message’) etc.

Before managed logging was introduced to FHAES, debugging was often handled through the use of Sys-
tem.out and System.err messages. To ensure that these messages are not lost we use another package called
SysOutOverSLF4J. This redirects messages sent to System.out and System.err to the logging system. This is
a temporary solution so when working on older classes, please take the time to transition these older calls to
the proper logging calls. We can then remove the need for SysOutOverSLF4J.

0.6 Preferences

It is helpful to remember certain user preferences e.g. last folder opened etc so that they don't have to do
tasks repeatedly. This is achieved through the use of the FHAESPreferences class. This stores preferences
in a specific place on the users computer depending on the operating system they are using. For instance in
Windows preferences are stored in the registry and in Linux they are stored in a hidden file within the users
home folder.

The preferences are accessed from the static member as follows:

FHAESPreferences.setPref (PrefKey.PREFKEY, "value");

where PrefKey.PREFKEY is an enum containing a unique string to identify the preference, and the second
value is the string value to set.

To retrieve a preference, you use a similar syntax:
FHAESPreferences.getPref (PrefKey.PREFKEY, "default value");

When you get a preference the second parameter contains the default value to return if no preference is found.
There are a number of variations on the setPref and getPref functions which ensure the data type of the
preference you are saving/retrieving e.g. setIntPref, setBooleanPref etc.

9.7 Build script

FHAES is built using Maven and is controlled through the pom.xml file stored in the base of the FHAES source
code. It would be possible to distribute FHAES as an executable JAR file, however, we we have chosen to also
produce native installers for the major platforms. This gives us the opportunity to tightly integrate FHAES
into the users operating system making it behave more like the native applications they are used to using. For
instance, it means that we can associate the .FHX file extension in Windows with FHAES enabling users to
double click on files and have them open automatically. It also means the application has its own icon rather
than the generic Java coffee icon. In MacOSX it also means the menu bar is placed at the top of the screen
rather than in the window.

While you develop, Maven should automatically build FHAES for you in the background. Specific build
commands are only required as you approach a release. We use the standard Maven ‘life cycle' for building,
packaging and deploying FHAES. The method for doing this in Eclipse is by right clicking on the pom.xml file
and selecting Run as » Maven package etc. If the option you want is not displayed, you will need to create
an entry in the build menu by going to Run -» Run configurations, then create a new Maven Build with the
required ‘goal’. The main goals are as follows:
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clean - This deletes any previously compiled classes and packages in the target folder. It should only be
necessary to run this occassionally if Maven has got a bit confused. If this is the case you may also need
to force Eclipse to clean too by going to Project » Clean...

package - This compiles FHAES and builds a single executable JAR containing all dependencies (thanks to
the maven-shade-plugin) along with native Windows, MacOSX and Linux packages. These are all placed
in structured folders within ‘target
Binaries' ready for deploying on the website.

deploy - This uploads the compiled jar into the maven.tridas.org repository. Note that you will need to either
run this phase from the command line or by setting up a customer run configuration in Eclipse.

9.7.1 Windows installer

Maven generates the Windows executable for the Tellervo application through the 'launch4j’ plugin. Windows
users, however, expect an installer that will create menu entries and add uninstall options to the control panel.
An installer is also required to install the user manual.

The best open source tool for creating Windows installer scripts is NSIS (see http://nsis.sourceforge.
net). This is an extremely flexible scripting system that does all we need. If you have NSIS installed the
Maven package goal should create the Windows installer automatically. We use the Maven antrun plugin to
run the makensis executable. This script is stored in Native/BuildResources/WinBuild. The Maven resource
plugin moves it into the target folder and replaces the version numbering for use in filenames etc.

9.7.2 Mac package

The Maven osxappbundle plugin is able to produce both .app and .dmg files. Unfortunately, the libraries for
producing .dmg files are proprietary to Apple. When Maven is run on Windows or Linux, it is therefore only
able to produce a zipped .app file, and not .dmg. Note an antrun plugin is used to remove duplicate libraries
from the final package.

9.7.3 Linux Deb package

A Linux Debian package is produced using the JDeb Maven plugin. If Maven does its job properly, it should
all ‘just work’ as part of the standard maven package phase. In addition to the configuration in the pom.xml,
there are three files that are used to configure the final deb file. In src/deb/control/ there is a control file which
describes the runtime dependencies, maintainer of the package, description etc. In Native/BuildResources/Lin-
Build are two files, one a simple bash script that is used to launch FHAES on the users computer and the other
a .desktop file for configuring how it appears in the users menus. All three of these files are automatically
updated with the current version number, so hopefully you shouldn’t need to change anything.

9.8 Code signing

From Windows Vista and MacOSX 10.7 (Lion) onwards code signing has become important. Windows ap-
plications that are not signed result in terrifying warning messages, and in OSX by default they cannot even
be run. The idea behind code signing is that it provides some level of security for the user as code signing
certificates can be revoked if an application is deemed to be malicious.

To sign an application you first need a code signing certificate. In fact you need two: one for Windows and
Java; and another for OSX as Apple only support certificates issued by themselves. A generic Windows and
Java certificate can be purchased from a variety of suppliers (e.g. Verisign etc) the Apple certificate must be
purchased through the Apple Developer Connection.

Code signing the Java jars and Windows installers is handled within Maven. The current set up in the Maven
pom.xml file is configured for Ubuntu Linux. If you are developing on another platform you will need to make
changes.
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9.8.1 Signing Java jars

The Java jars are signed using a Java utility called jarsigner that comes with your JDK so there is nothing to
install. The pom.xml is currently hard coded to access the certificate and key files stored on the lead FHAES
development machine. You will need to alter these settings accordingly.

9.8.2 Signing Windows executables

Windows executables are typically signed using the Windows-only Microsoft utility signcode. On Linux and
OSX there is an open source equivalent called osslsigncode which can be downloaded from Sourceforge and
compiled. You may also be able to find third-party binaries for your operating system.

The FHAES pom.xml file has been configured to run osslsigncode with the location and naming of the certificate
and key files hard coded. Change these to match the certificate you are using. If you are using signcode instead
of osslsigncode you should find that the parameters are very similar. You should hopefully be able to modify
them without too much difficulty.

Please note that both signcode and osslsigncode need the certificate in a different format to jarsigner. You
can use openss| to do this conversion and there are many tutorials online which describe how.

9.8.3 Signing OSX executables

With the inclusion of the GateKeeper technology in OSX 10.7, code signing has become almost essential in
OSX. The jar wrapped in native apps will fail to load under default security settings and the OS reports the file
as ‘damaged’ because the JavaApplicationStub used has an existing signature and the contents of the package
has changed. This signature must be removed or replaced with another before the application can be launched.
If a self-signed or third party certificate is used then the GateKeeper will block the application saying that it
isn't from a trusted developer. It is possible for users to go to the System Properties » Security and Privacy
and set the application security level to ‘any developer’ but this is long and involved for novice users and results
in a lot of warnings. Please note that all signing of Mac application must be done on a recent Mac. There are
no cross-platform tools currently available.

The best way to fix the issue is to sign the application using an Apple certified Developer ID certificate and
GateKeeper will allow the application to launch with the default security settings. Obtaining this certificate is
a fairly involved process and requires an annual subscription to Apple Developer Connection. Note that your
certificate must begin with ‘Developer ID’' to work. Other Apple-provided certificates are used for distributing
your application through the Mac App store and will not work.

Once you have your Developer ID certificate installed on your Mac, you can sign your application using the
command:

codesign -f -s "Developer ID" FHAES.app
You can then verify that the signing worked by doing:

codesign --display --verbose=4 FHAES.app

9.9 Developing graphical interfaces

The graphical interfaces in FHAES have mostly been designed using the Google WindowBuilder Pro tool with
Eclipse. Unlike other graphical design tools WindowBuilder has the benefit of being able to parse (most) hand
written layout code, so it is possible to manually edit the layouts if you prefer. However, most of the interfaces
are built using the MiglLayout layout manager which can be a little tricky to code by hand.
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9.10 Writing documentation

The documentation in FHAES is written in the well established typesetting language IASTEX2z. IATEX is a great
tool for producing high quality documentation with a good structure and style. Unlike standard WYSIWYG
(what you see is what you get) word processing applications like Microsoft Word, IATEX uses simple plain text
code to layout a document so that it is often described as WYSIWYM (what you see is what you mean)! The
style of a IATEX document is handled separated enabling the author to concentrate on content. By removing the
possibility for authors to tinker with font sizes etc, IATEX forces you to create clear, well structured documents.
For further details see http://en.wikibooks.org/wiki/LaTeX/.

IATEX has fantastic cross-referencing and citation functionality built in. Please follow the lead of the existing
documentation!

9.11 Making a new release

Making a new release should be a relatively quick and simply process, but there are still a few things to
remember:

» Make sure this documentation is up-to-date.
» Update the logging appenders to an appropriate level so that the user is not swamped by debug messages.

» Increment the build version number(s) in the pom.xml of FHAES and any of the other modules as
applicable.

» Check the code in Eclipse and eliminate as many warnings as possible.

» Make sure the developers metadata is correct in the pom.xml. Add any new developers that have joined
the project since the last release.

» Run Maven deploy on the secondary packages.

» Run Maven package on the FHAES project itself.

» Test! Make sure all packages are working on the major operating systems being supported.

» Copy the packages to the website and change the most recent build number on the website. This will

inform users of the new release the next time they load FHAES.
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Appendix A

GNU General Public License

FHAES is released under the GNU General Public License (GPL) version 3.
Copyright (©) 2014 FHAES Team

This program is free software: you can redistribute it and/or modify it under the terms of the GNU General
Public License as published by the Free Software Foundation, either version 3 of the License, or (at your option)
any later version.

This program is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY:; without even
the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU
General Public License for more details.

A.1 Preamble

Copyright (©) 2007 Free Software Foundation, Inc. http://fsf.org/
Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.
The GNU General Public License is a free, copyleft license for software and other kinds of works.

The licenses for most software and other practical works are designed to take away your freedom to share and change the works. By
contrast, the GNU General Public License is intended to guarantee your freedom to share and change all versions of a program—to
make sure it remains free software for all its users. We, the Free Software Foundation, use the GNU General Public License for
most of our software; it applies also to any other work released this way by its authors. You can apply it to your programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are designed to make sure
that you have the freedom to distribute copies of free software (and charge for them if you wish), that you receive source code or
can get it if you want it, that you can change the software or use pieces of it in new free programs, and that you know you can
do these things.

To protect your rights, we need to prevent others from denying you these rights or asking you to surrender the rights. Therefore,
you have certain responsibilities if you distribute copies of the software, or if you modify it: responsibilities to respect the freedom
of others.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must pass on to the recipients the same
freedoms that you received. You must make sure that they, too, receive or can get the source code. And you must show them
these terms so they know their rights.

Developers that use the GNU GPL protect your rights with two steps: (1) assert copyright on the software, and (2) offer you this
License giving you legal permission to copy, distribute and/or modify it.

For the developers’ and authors’ protection, the GPL clearly explains that there is no warranty for this free software. For both users’
and authors’ sake, the GPL requires that modified versions be marked as changed, so that their problems will not be attributed
erroneously to authors of previous versions.

Some devices are designed to deny users access to install or run modified versions of the software inside them, although the
manufacturer can do so. This is fundamentally incompatible with the aim of protecting users’ freedom to change the software.
The systematic pattern of such abuse occurs in the area of products for individuals to use, which is precisely where it is most
unacceptable. Therefore, we have designed this version of the GPL to prohibit the practice for those products. If such problems
arise substantially in other domains, we stand ready to extend this provision to those domains in future versions of the GPL, as
needed to protect the freedom of users.
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Finally, every program is threatened constantly by software patents. States should not allow patents to restrict development and
use of software on general-purpose computers, but in those that do, we wish to avoid the special danger that patents applied to
a free program could make it effectively proprietary. To prevent this, the GPL assures that patents cannot be used to render the
program non-free.

The precise terms and conditions for copying, distribution and modification follow.

A.2 Terms and Conditions

0. Definitions.

“This License" refers to version 3 of the GNU General Public License.
“Copyright” also means copyright-like laws that apply to other kinds of works, such as semiconductor masks.

“The Program” refers to any copyrightable work licensed under this License. Each licensee is addressed as ‘“you”. “Li-
censees’ and ‘recipients” may be individuals or organizations.

To “modify” a work means to copy from or adapt all or part of the work in a fashion requiring copyright permission, other
than the making of an exact copy. The resulting work is called a “modified version” of the earlier work or a work “based
on” the earlier work.

A “covered work” means either the unmodified Program or a work based on the Program.

To “propagate” a work means to do anything with it that, without permission, would make you directly or secondarily liable
for infringement under applicable copyright law, except executing it on a computer or modifying a private copy. Propagation
includes copying, distribution (with or without modification), making available to the public, and in some countries other
activities as well.

To “convey” a work means any kind of propagation that enables other parties to make or receive copies. Mere interaction
with a user through a computer network, with no transfer of a copy, is not conveying.

An interactive user interface displays “Appropriate Legal Notices” to the extent that it includes a convenient and prominently
visible feature that (1) displays an appropriate copyright notice, and (2) tells the user that there is no warranty for the
work (except to the extent that warranties are provided), that licensees may convey the work under this License, and how
to view a copy of this License. If the interface presents a list of user commands or options, such as a menu, a prominent
item in the list meets this criterion.

Source Code.

The “source code” for a work means the preferred form of the work for making modifications to it. “Object code” means
any non-source form of a work.

A “Standard Interface” means an interface that either is an official standard defined by a recognized standards body, or, in
the case of interfaces specified for a particular programming language, one that is widely used among developers working
in that language.

The “System Libraries” of an executable work include anything, other than the work as a whole, that (a) is included in
the normal form of packaging a Major Component, but which is not part of that Major Component, and (b) serves only
to enable use of the work with that Major Component, or to implement a Standard Interface for which an implementation
is available to the public in source code form. A "Major Component”, in this context, means a major essential component
(kernel, window system, and so on) of the specific operating system (if any) on which the executable work runs, or a
compiler used to produce the work, or an object code interpreter used to run it.

The “Corresponding Source” for a work in object code form means all the source code needed to generate, install, and (for
an executable work) run the object code and to modify the work, including scripts to control those activities. However, it
does not include the work’s System Libraries, or general-purpose tools or generally available free programs which are used
unmodified in performing those activities but which are not part of the work. For example, Corresponding Source includes
interface definition files associated with source files for the work, and the source code for shared libraries and dynamically
linked subprograms that the work is specifically designed to require, such as by intimate data communication or control
flow between those subprograms and other parts of the work.

The Corresponding Source need not include anything that users can regenerate automatically from other parts of the
Corresponding Source.

The Corresponding Source for a work in source code form is that same work.

Basic Permissions.

All rights granted under this License are granted for the term of copyright on the Program, and are irrevocable provided the
stated conditions are met. This License explicitly affirms your unlimited permission to run the unmodified Program. The
output from running a covered work is covered by this License only if the output, given its content, constitutes a covered
work. This License acknowledges your rights of fair use or other equivalent, as provided by copyright law.

You may make, run and propagate covered works that you do not convey, without conditions so long as your license otherwise
remains in force. You may convey covered works to others for the sole purpose of having them make modifications exclusively
for you, or provide you with facilities for running those works, provided that you comply with the terms of this License in
conveying all material for which you do not control copyright. Those thus making or running the covered works for you
must do so exclusively on your behalf, under your direction and control, on terms that prohibit them from making any
copies of your copyrighted material outside their relationship with you.

Conveying under any other circumstances is permitted solely under the conditions stated below. Sublicensing is not allowed,;
section 10 makes it unnecessary.
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3. Protecting Users’ Legal Rights From Anti-Circumvention Law.

No covered work shall be deemed part of an effective technological measure under any applicable law fulfilling obligations
under article 11 of the WIPO copyright treaty adopted on 20 December 1996, or similar laws prohibiting or restricting
circumvention of such measures.

When you convey a covered work, you waive any legal power to forbid circumvention of technological measures to the
extent such circumvention is effected by exercising rights under this License with respect to the covered work, and you
disclaim any intention to limit operation or modification of the work as a means of enforcing, against the work's users, your
or third parties’ legal rights to forbid circumvention of technological measures.

4. Conveying Verbatim Copies.
You may convey verbatim copies of the Program's source code as you receive it, in any medium, provided that you
conspicuously and appropriately publish on each copy an appropriate copyright notice; keep intact all notices stating that
this License and any non-permissive terms added in accord with section 7 apply to the code; keep intact all notices of the
absence of any warranty; and give all recipients a copy of this License along with the Program.
You may charge any price or no price for each copy that you convey, and you may offer support or warranty protection for
a fee.

5. Conveying Modified Source Versions.

You may convey a work based on the Program, or the modifications to produce it from the Program, in the form of source
code under the terms of section 4, provided that you also meet all of these conditions:

(a) The work must carry prominent notices stating that you modified it, and giving a relevant date.

(b) The work must carry prominent notices stating that it is released under this License and any conditions added under
section 7. This requirement modifies the requirement in section 4 to “keep intact all notices”.

(c) You must license the entire work, as a whole, under this License to anyone who comes into possession of a copy.
This License will therefore apply, along with any applicable section 7 additional terms, to the whole of the work, and
all its parts, regardless of how they are packaged. This License gives no permission to license the work in any other
way, but it does not invalidate such permission if you have separately received it.

(d) If the work has interactive user interfaces, each must display Appropriate Legal Notices; however, if the Program has
interactive interfaces that do not display Appropriate Legal Notices, your work need not make them do so.

A compilation of a covered work with other separate and independent works, which are not by their nature extensions of
the covered work, and which are not combined with it such as to form a larger program, in or on a volume of a storage
or distribution medium, is called an “aggregate” if the compilation and its resulting copyright are not used to limit the
access or legal rights of the compilation’s users beyond what the individual works permit. Inclusion of a covered work in
an aggregate does not cause this License to apply to the other parts of the aggregate.

6. Conveying Non-Source Forms.

You may convey a covered work in object code form under the terms of sections 4 and 5, provided that you also convey
the machine-readable Corresponding Source under the terms of this License, in one of these ways:

(a) Convey the object code in, or embodied in, a physical product (including a physical distribution medium), accompanied
by the Corresponding Source fixed on a durable physical medium customarily used for software interchange.

(b) Convey the object code in, or embodied in, a physical product (including a physical distribution medium), accompanied
by a written offer, valid for at least three years and valid for as long as you offer spare parts or customer support for
that product model, to give anyone who possesses the object code either (1) a copy of the Corresponding Source for
all the software in the product that is covered by this License, on a durable physical medium customarily used for
software interchange, for a price no more than your reasonable cost of physically performing this conveying of source,
or (2) access to copy the Corresponding Source from a network server at no charge.

(c) Convey individual copies of the object code with a copy of the written offer to provide the Corresponding Source.
This alternative is allowed only occasionally and noncommercially, and only if you received the object code with such
an offer, in accord with subsection 6b.

(d) Convey the object code by offering access from a designated place (gratis or for a charge), and offer equivalent
access to the Corresponding Source in the same way through the same place at no further charge. You need not
require recipients to copy the Corresponding Source along with the object code. If the place to copy the object code
is a network server, the Corresponding Source may be on a different server (operated by you or a third party) that
supports equivalent copying facilities, provided you maintain clear directions next to the object code saying where to
find the Corresponding Source. Regardless of what server hosts the Corresponding Source, you remain obligated to
ensure that it is available for as long as needed to satisfy these requirements.

(e) Convey the object code using peer-to-peer transmission, provided you inform other peers where the object code and
Corresponding Source of the work are being offered to the general public at no charge under subsection 6d.

A separable portion of the object code, whose source code is excluded from the Corresponding Source as a System Library,
need not be included in conveying the object code work.

A “User Product” is either (1) a “consumer product”, which means any tangible personal property which is normally used
for personal, family, or household purposes, or (2) anything designed or sold for incorporation into a dwelling. In determining
whether a product is a consumer product, doubtful cases shall be resolved in favor of coverage. For a particular product
received by a particular user, "normally used” refers to a typical or common use of that class of product, regardless of
the status of the particular user or of the way in which the particular user actually uses, or expects or is expected to use,
the product. A product is a consumer product regardless of whether the product has substantial commercial, industrial or
non-consumer uses, unless such uses represent the only significant mode of use of the product.

“Installation Information” for a User Product means any methods, procedures, authorization keys, or other information
required to install and execute modified versions of a covered work in that User Product from a modified version of its
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Corresponding Source. The information must suffice to ensure that the continued functioning of the modified object code
is in no case prevented or interfered with solely because modification has been made.

If you convey an object code work under this section in, or with, or specifically for use in, a User Product, and the conveying
occurs as part of a transaction in which the right of possession and use of the User Product is transferred to the recipient
in perpetuity or for a fixed term (regardless of how the transaction is characterized), the Corresponding Source conveyed
under this section must be accompanied by the Installation Information. But this requirement does not apply if neither you
nor any third party retains the ability to install modified object code on the User Product (for example, the work has been
installed in ROM).

The requirement to provide Installation Information does not include a requirement to continue to provide support service,
warranty, or updates for a work that has been modified or installed by the recipient, or for the User Product in which it
has been modified or installed. Access to a network may be denied when the modification itself materially and adversely
affects the operation of the network or violates the rules and protocols for communication across the network.
Corresponding Source conveyed, and Installation Information provided, in accord with this section must be in a format that
is publicly documented (and with an implementation available to the public in source code form), and must require no
special password or key for unpacking, reading or copying.

. Additional Terms.

“Additional permissions” are terms that supplement the terms of this License by making exceptions from one or more of its
conditions. Additional permissions that are applicable to the entire Program shall be treated as though they were included
in this License, to the extent that they are valid under applicable law. If additional permissions apply only to part of the
Program, that part may be used separately under those permissions, but the entire Program remains governed by this
License without regard to the additional permissions.

When you convey a copy of a covered work, you may at your option remove any additional permissions from that copy, or
from any part of it. (Additional permissions may be written to require their own removal in certain cases when you modify
the work.) You may place additional permissions on material, added by you to a covered work, for which you have or can
give appropriate copyright permission.
Notwithstanding any other provision of this License, for material you add to a covered work, you may (if authorized by the
copyright holders of that material) supplement the terms of this License with terms:
(a) Disclaiming warranty or limiting liability differently from the terms of sections 15 and 16 of this License; or
(b) Requiring preservation of specified reasonable legal notices or author attributions in that material or in the Appropriate
Legal Notices displayed by works containing it; or
(c) Prohibiting misrepresentation of the origin of that material, or requiring that modified versions of such material be
marked in reasonable ways as different from the original version; or
(d) Limiting the use for publicity purposes of names of licensors or authors of the material; or
(e) Declining to grant rights under trademark law for use of some trade names, trademarks, or service marks; or
(f) Requiring indemnification of licensors and authors of that material by anyone who conveys the material (or modified
versions of it) with contractual assumptions of liability to the recipient, for any liability that these contractual
assumptions directly impose on those licensors and authors.
All other non-permissive additional terms are considered “further restrictions” within the meaning of section 10. If the
Program as you received it, or any part of it, contains a notice stating that it is governed by this License along with a term
that is a further restriction, you may remove that term. If a license document contains a further restriction but permits
relicensing or conveying under this License, you may add to a covered work material governed by the terms of that license
document, provided that the further restriction does not survive such relicensing or conveying.
If you add terms to a covered work in accord with this section, you must place, in the relevant source files, a statement of
the additional terms that apply to those files, or a notice indicating where to find the applicable terms.
Additional terms, permissive or non-permissive, may be stated in the form of a separately written license, or stated as
exceptions; the above requirements apply either way.

. Termination.

You may not propagate or modify a covered work except as expressly provided under this License. Any attempt otherwise
to propagate or modify it is void, and will automatically terminate your rights under this License (including any patent
licenses granted under the third paragraph of section 11).

However, if you cease all violation of this License, then your license from a particular copyright holder is reinstated (a)
provisionally, unless and until the copyright holder explicitly and finally terminates your license, and (b) permanently, if the
copyright holder fails to notify you of the violation by some reasonable means prior to 60 days after the cessation.
Moreover, your license from a particular copyright holder is reinstated permanently if the copyright holder notifies you of
the violation by some reasonable means, this is the first time you have received notice of violation of this License (for any
work) from that copyright holder, and you cure the violation prior to 30 days after your receipt of the notice.

Termination of your rights under this section does not terminate the licenses of parties who have received copies or rights
from you under this License. If your rights have been terminated and not permanently reinstated, you do not qualify to
receive new licenses for the same material under section 10.

. Acceptance Not Required for Having Copies.

You are not required to accept this License in order to receive or run a copy of the Program. Ancillary propagation of
a covered work occurring solely as a consequence of using peer-to-peer transmission to receive a copy likewise does not
require acceptance. However, nothing other than this License grants you permission to propagate or modify any covered
work. These actions infringe copyright if you do not accept this License. Therefore, by modifying or propagating a covered
work, you indicate your acceptance of this License to do so.
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10.

11.

12.

13.

14.

Automatic Licensing of Downstream Recipients.

Each time you convey a covered work, the recipient automatically receives a license from the original licensors, to run,
modify and propagate that work, subject to this License. You are not responsible for enforcing compliance by third parties
with this License.

An ‘“entity transaction” is a transaction transferring control of an organization, or substantially all assets of one, or
subdividing an organization, or merging organizations. If propagation of a covered work results from an entity transaction,
each party to that transaction who receives a copy of the work also receives whatever licenses to the work the party's
predecessor in interest had or could give under the previous paragraph, plus a right to possession of the Corresponding
Source of the work from the predecessor in interest, if the predecessor has it or can get it with reasonable efforts.

You may not impose any further restrictions on the exercise of the rights granted or affirmed under this License. For
example, you may not impose a license fee, royalty, or other charge for exercise of rights granted under this License, and
you may not initiate litigation (including a cross-claim or counterclaim in a lawsuit) alleging that any patent claim is
infringed by making, using, selling, offering for sale, or importing the Program or any portion of it.

Patents.

A “contributor” is a copyright holder who authorizes use under this License of the Program or a work on which the Program
is based. The work thus licensed is called the contributor’'s “contributor version”.

A contributor’'s “essential patent claims” are all patent claims owned or controlled by the contributor, whether already
acquired or hereafter acquired, that would be infringed by some manner, permitted by this License, of making, using, or
selling its contributor version, but do not include claims that would be infringed only as a consequence of further modification
of the contributor version. For purposes of this definition, “control” includes the right to grant patent sublicenses in a
manner consistent with the requirements of this License.

Each contributor grants you a non-exclusive, worldwide, royalty-free patent license under the contributor’s essential patent
claims, to make, use, sell, offer for sale, import and otherwise run, modify and propagate the contents of its contributor
version.

In the following three paragraphs, a “patent license” is any express agreement or commitment, however denominated, not
to enforce a patent (such as an express permission to practice a patent or covenant not to sue for patent infringement).
To “grant” such a patent license to a party means to make such an agreement or commitment not to enforce a patent
against the party.

If you convey a covered work, knowingly relying on a patent license, and the Corresponding Source of the work is not
available for anyone to copy, free of charge and under the terms of this License, through a publicly available network server
or other readily accessible means, then you must either (1) cause the Corresponding Source to be so available, or (2) arrange
to deprive yourself of the benefit of the patent license for this particular work, or (3) arrange, in a manner consistent with
the requirements of this License, to extend the patent license to downstream recipients. “Knowingly relying” means you
have actual knowledge that, but for the patent license, your conveying the covered work in a country, or your recipient's
use of the covered work in a country, would infringe one or more identifiable patents in that country that you have reason
to believe are valid.

If, pursuant to or in connection with a single transaction or arrangement, you convey, or propagate by procuring conveyance
of, a covered work, and grant a patent license to some of the parties receiving the covered work authorizing them to use,
propagate, modify or convey a specific copy of the covered work, then the patent license you grant is automatically extended
to all recipients of the covered work and works based on it.

A patent license is “discriminatory” if it does not include within the scope of its coverage, prohibits the exercise of, or
is conditioned on the non-exercise of one or more of the rights that are specifically granted under this License. You may
not convey a covered work if you are a party to an arrangement with a third party that is in the business of distributing
software, under which you make payment to the third party based on the extent of your activity of conveying the work, and
under which the third party grants, to any of the parties who would receive the covered work from you, a discriminatory
patent license (a) in connection with copies of the covered work conveyed by you (or copies made from those copies), or
(b) primarily for and in connection with specific products or compilations that contain the covered work, unless you entered
into that arrangement, or that patent license was granted, prior to 28 March 2007.

Nothing in this License shall be construed as excluding or limiting any implied license or other defenses to infringement
that may otherwise be available to you under applicable patent law.

No Surrender of Others’ Freedom.

If conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the conditions of this
License, they do not excuse you from the conditions of this License. If you cannot convey a covered work so as to satisfy
simultaneously your obligations under this License and any other pertinent obligations, then as a consequence you may not
convey it at all. For example, if you agree to terms that obligate you to collect a royalty for further conveying from those
to whom you convey the Program, the only way you could satisfy both those terms and this License would be to refrain
entirely from conveying the Program.

Use with the GNU Affero General Public License.

Notwithstanding any other provision of this License, you have permission to link or combine any covered work with a work
licensed under version 3 of the GNU Affero General Public License into a single combined work, and to convey the resulting
work. The terms of this License will continue to apply to the part which is the covered work, but the special requirements of
the GNU Affero General Public License, section 13, concerning interaction through a network will apply to the combination
as such.

Revised Versions of this License.

The Free Software Foundation may publish revised and/or new versions of the GNU General Public License from time to
time. Such new versions will be similar in spirit to the present version, but may differ in detail to address new problems or
concerns.
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Each version is given a distinguishing version number. If the Program specifies that a certain numbered version of the
GNU General Public License “or any later version” applies to it, you have the option of following the terms and conditions
either of that numbered version or of any later version published by the Free Software Foundation. If the Program does
not specify a version number of the GNU General Public License, you may choose any version ever published by the Free
Software Foundation.

If the Program specifies that a proxy can decide which future versions of the GNU General Public License can be used, that
proxy's public statement of acceptance of a version permanently authorizes you to choose that version for the Program.
Later license versions may give you additional or different permissions. However, no additional obligations are imposed on
any author or copyright holder as a result of your choosing to follow a later version.

Disclaimer of Warranty.

THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT
WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE
PROGRAM “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU.
SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR
OR CORRECTION.

Limitation of Liability.

IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT
HOLDER, OR ANY OTHER PARTY WHO MODIFIES AND/OR CONVEYS THE PROGRAM AS PERMITTED ABOVE,
BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL
DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED
TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD
PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH
HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

Interpretation of Sections 15 and 16.

If the disclaimer of warranty and limitation of liability provided above cannot be given local legal effect according to their
terms, reviewing courts shall apply local law that most closely approximates an absolute waiver of all civil liability in
connection with the Program, unless a warranty or assumption of liability accompanies a copy of the Program in return for
a fee.



Appendix B

GNU Free Documentation License

This manual is released inder the GNU Free Documentation License (FDL) v1.3.

Permission is granted to copy, distribute and/or modify this document under the terms of the GNU Free
Documentation License, Version 1.3 or any later version published by the Free Software Foundation; with no
Invariant Sections, no Front-Cover Texts, and no Back-Cover Texts.

B.1 Preamble

Copyright (©) 2000, 2001, 2002, 2007, 2008 Free Software Foundation, Inc. http://fsf.org/
Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

The purpose of this License is to make a manual, textbook, or other functional and useful document “free” in the sense of
freedom: to assure everyone the effective freedom to copy and redistribute it, with or without modifying it, either commercially
or noncommercially. Secondarily, this License preserves for the author and publisher a way to get credit for their work, while not
being considered responsible for modifications made by others.

This License is a kind of “copyleft”, which means that derivative works of the document must themselves be free in the same
sense. It complements the GNU General Public License, which is a copyleft license designed for free software.

We have designed this License in order to use it for manuals for free software, because free software needs free documentation: a
free program should come with manuals providing the same freedoms that the software does. But this License is not limited to
software manuals; it can be used for any textual work, regardless of subject matter or whether it is published as a printed book.

We recommend this License principally for works whose purpose is instruction or reference.

B.2 Terms and conditions

1. Applicability and definitions

This License applies to any manual or other work, in any medium, that contains a notice placed by the copyright holder
saying it can be distributed under the terms of this License. Such a notice grants a world-wide, royalty-free license, unlimited
in duration, to use that work under the conditions stated herein. The “"Document”, below, refers to any such manual or
work. Any member of the public is a licensee, and is addressed as “you”. You accept the license if you copy, modify or
distribute the work in a way requiring permission under copyright law.

A “Modified Version” of the Document means any work containing the Document or a portion of it, either copied verbatim,
or with modifications and/or translated into another language.

A “Secondary Section” is a named appendix or a front-matter section of the Document that deals exclusively with the
relationship of the publishers or authors of the Document to the Document’s overall subject (or to related matters) and
contains nothing that could fall directly within that overall subject. (Thus, if the Document is in part a textbook of
mathematics, a Secondary Section may not explain any mathematics.) The relationship could be a matter of historical
connection with the subject or with related matters, or of legal, commercial, philosophical, ethical or political position
regarding them.

The “Invariant Sections” are certain Secondary Sections whose titles are designated, as being those of Invariant Sections,
in the notice that says that the Document is released under this License. If a section does not fit the above definition of
Secondary then it is not allowed to be designated as Invariant. The Document may contain zero Invariant Sections. If the
Document does not identify any Invariant Sections then there are none.
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The “Cover Texts" are certain short passages of text that are listed, as Front-Cover Texts or Back-Cover Texts, in the
notice that says that the Document is released under this License. A Front-Cover Text may be at most 5 words, and a
Back-Cover Text may be at most 25 words.

A “Transparent” copy of the Document means a machine-readable copy, represented in a format whose specification is
available to the general public, that is suitable for revising the document straightforwardly with generic text editors or (for
images composed of pixels) generic paint programs or (for drawings) some widely available drawing editor, and that is
suitable for input to text formatters or for automatic translation to a variety of formats suitable for input to text formatters.
A copy made in an otherwise Transparent file format whose markup, or absence of markup, has been arranged to thwart
or discourage subsequent modification by readers is not Transparent. An image format is not Transparent if used for any
substantial amount of text. A copy that is not “Transparent” is called “Opaque”.

Examples of suitable formats for Transparent copies include plain ASCII without markup, Texinfo input format, LaTeX
input format, SGML or XML using a publicly available DTD, and standard-conforming simple HTML, PostScript or PDF
designed for human modification. Examples of transparent image formats include PNG, XCF and JPG. Opaque formats
include proprietary formats that can be read and edited only by proprietary word processors, SGML or XML for which the
DTD and/or processing tools are not generally available, and the machine-generated HTML, PostScript or PDF produced
by some word processors for output purposes only.

The “Title Page” means, for a printed book, the title page itself, plus such following pages as are needed to hold, legibly,
the material this License requires to appear in the title page. For works in formats which do not have any title page as
such, “Title Page” means the text near the most prominent appearance of the work'’s title, preceding the beginning of the
body of the text.

The “publisher” means any person or entity that distributes copies of the Document to the public.

A section “Entitled XYZ" means a named subunit of the Document whose title either is precisely XYZ or contains XYZ in
parentheses following text that translates XYZ in another language. (Here XYZ stands for a specific section name mentioned
below, such as “Acknowledgements”’, “Dedications’, “Endorsements”, or “History”.) To “Preserve the Title” of such a
section when you modify the Document means that it remains a section “Entitled XYZ" according to this definition.

The Document may include Warranty Disclaimers next to the notice which states that this License applies to the Document.
These Warranty Disclaimers are considered to be included by reference in this License, but only as regards disclaiming
warranties: any other implication that these Warranty Disclaimers may have is void and has no effect on the meaning of
this License.

. Verbatim copying

You may copy and distribute the Document in any medium, either commercially or noncommercially, provided that this
License, the copyright notices, and the license notice saying this License applies to the Document are reproduced in all
copies, and that you add no other conditions whatsoever to those of this License. You may not use technical measures
to obstruct or control the reading or further copying of the copies you make or distribute. However, you may accept
compensation in exchange for copies. If you distribute a large enough number of copies you must also follow the conditions
in section 3.

You may also lend copies, under the same conditions stated above, and you may publicly display copies.

. Copying in quantity

If you publish printed copies (or copies in media that commonly have printed covers) of the Document, numbering more
than 100, and the Document’s license notice requires Cover Texts, you must enclose the copies in covers that carry, clearly
and legibly, all these Cover Texts: Front-Cover Texts on the front cover, and Back-Cover Texts on the back cover. Both
covers must also clearly and legibly identify you as the publisher of these copies. The front cover must present the full title
with all words of the title equally prominent and visible. You may add other material on the covers in addition. Copying
with changes limited to the covers, as long as they preserve the title of the Document and satisfy these conditions, can be
treated as verbatim copying in other respects.

If the required texts for either cover are too voluminous to fit legibly, you should put the first ones listed (as many as fit
reasonably) on the actual cover, and continue the rest onto adjacent pages.

If you publish or distribute Opaque copies of the Document numbering more than 100, you must either include a machine-
readable Transparent copy along with each Opaque copy, or state in or with each Opaque copy a computer-network location
from which the general network-using public has access to download using public-standard network protocols a complete
Transparent copy of the Document, free of added material. If you use the latter option, you must take reasonably prudent
steps, when you begin distribution of Opaque copies in quantity, to ensure that this Transparent copy will remain thus
accessible at the stated location until at least one year after the last time you distribute an Opaque copy (directly or through
your agents or retailers) of that edition to the public.

It is requested, but not required, that you contact the authors of the Document well before redistributing any large number
of copies, to give them a chance to provide you with an updated version of the Document.

Modifications

You may copy and distribute a Modified Version of the Document under the conditions of sections 2 and 3 above, provided
that you release the Modified Version under precisely this License, with the Modified Version filling the role of the Document,
thus licensing distribution and modification of the Modified Version to whoever possesses a copy of it. In addition, you
must do these things in the Modified Version:

A. Use in the Title Page (and on the covers, if any) a title distinct from that of the Document, and from those of
previous versions (which should, if there were any, be listed in the History section of the Document). You may use
the same title as a previous version if the original publisher of that version gives permission.

B. List on the Title Page, as authors, one or more persons or entities responsible for authorship of the modifications in
the Modified Version, together with at least five of the principal authors of the Document (all of its principal authors,
if it has fewer than five), unless they release you from this requirement.
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State on the Title page the name of the publisher of the Modified Version, as the publisher.
Preserve all the copyright notices of the Document.
Add an appropriate copyright notice for your modifications adjacent to the other copyright notices.

mmUAN

Include, immediately after the copyright notices, a license notice giving the public permission to use the Modified
Version under the terms of this License, in the form shown in the Addendum below.

G. Preserve in that license notice the full lists of Invariant Sections and required Cover Texts given in the Document'’s
license notice.

H. Include an unaltered copy of this License.

I. Preserve the section Entitled “History”, Preserve its Title, and add to it an item stating at least the title, year, new
authors, and publisher of the Modified Version as given on the Title Page. If there is no section Entitled “History” in
the Document, create one stating the title, year, authors, and publisher of the Document as given on its Title Page,
then add an item describing the Modified Version as stated in the previous sentence.

J. Preserve the network location, if any, given in the Document for public access to a Transparent copy of the Document,
and likewise the network locations given in the Document for previous versions it was based on. These may be placed
in the “History” section. You may omit a network location for a work that was published at least four years before
the Document itself, or if the original publisher of the version it refers to gives permission.

K. For any section Entitled “Acknowledgements” or “Dedications”, Preserve the Title of the section, and preserve in
the section all the substance and tone of each of the contributor acknowledgements and/or dedications given therein.

L. Preserve all the Invariant Sections of the Document, unaltered in their text and in their titles. Section numbers or
the equivalent are not considered part of the section titles.

M. Delete any section Entitled “Endorsements”. Such a section may not be included in the Modified Version.

N. Do not retitle any existing section to be Entitled “Endorsements” or to conflict in title with any Invariant Section.

O. Preserve any Warranty Disclaimers.

If the Modified Version includes new front-matter sections or appendices that qualify as Secondary Sections and contain
no material copied from the Document, you may at your option designate some or all of these sections as invariant. To do
this, add their titles to the list of Invariant Sections in the Modified Version's license notice. These titles must be distinct
from any other section titles.

You may add a section Entitled “Endorsements”, provided it contains nothing but endorsements of your Modified Version
by various parties—for example, statements of peer review or that the text has been approved by an organization as the
authoritative definition of a standard.

You may add a passage of up to five words as a Front-Cover Text, and a passage of up to 25 words as a Back-Cover Text,
to the end of the list of Cover Texts in the Modified Version. Only one passage of Front-Cover Text and one of Back-Cover
Text may be added by (or through arrangements made by) any one entity. If the Document already includes a cover text
for the same cover, previously added by you or by arrangement made by the same entity you are acting on behalf of, you
may not add another; but you may replace the old one, on explicit permission from the previous publisher that added the
old one.

The author(s) and publisher(s) of the Document do not by this License give permission to use their names for publicity for
or to assert or imply endorsement of any Modified Version.

Combining documents

You may combine the Document with other documents released under this License, under the terms defined in section 4
above for modified versions, provided that you include in the combination all of the Invariant Sections of all of the original
documents, unmodified, and list them all as Invariant Sections of your combined work in its license notice, and that you
preserve all their Warranty Disclaimers.

The combined work need only contain one copy of this License, and multiple identical Invariant Sections may be replaced
with a single copy. If there are multiple Invariant Sections with the same name but different contents, make the title of
each such section unique by adding at the end of it, in parentheses, the name of the original author or publisher of that
section if known, or else a unique number. Make the same adjustment to the section titles in the list of Invariant Sections
in the license notice of the combined work.

In the combination, you must combine any sections Entitled “History” in the various original documents, forming one section
Entitled “History”; likewise combine any sections Entitled “Acknowledgements”, and any sections Entitled “Dedications”.
You must delete all sections Entitled “Endorsements”.

Collections of documents

You may make a collection consisting of the Document and other documents released under this License, and replace the
individual copies of this License in the various documents with a single copy that is included in the collection, provided that
you follow the rules of this License for verbatim copying of each of the documents in all other respects.

You may extract a single document from such a collection, and distribute it individually under this License, provided you
insert a copy of this License into the extracted document, and follow this License in all other respects regarding verbatim
copying of that document.

. Aggregation with independent works

A compilation of the Document or its derivatives with other separate and independent documents or works, in or on a
volume of a storage or distribution medium, is called an “aggregate” if the copyright resulting from the compilation is not
used to limit the legal rights of the compilation’s users beyond what the individual works permit. When the Document
is included in an aggregate, this License does not apply to the other works in the aggregate which are not themselves
derivative works of the Document.

If the Cover Text requirement of section 3 is applicable to these copies of the Document, then if the Document is less than
one half of the entire aggregate, the Document’s Cover Texts may be placed on covers that bracket the Document within
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the aggregate, or the electronic equivalent of covers if the Document is in electronic form. Otherwise they must appear on
printed covers that bracket the whole aggregate.

Translation

Translation is considered a kind of modification, so you may distribute translations of the Document under the terms of
section 4. Replacing Invariant Sections with translations requires special permission from their copyright holders, but you
may include translations of some or all Invariant Sections in addition to the original versions of these Invariant Sections.
You may include a translation of this License, and all the license notices in the Document, and any Warranty Disclaimers,
provided that you also include the original English version of this License and the original versions of those notices and
disclaimers. In case of a disagreement between the translation and the original version of this License or a notice or
disclaimer, the original version will prevail.

If a section in the Document is Entitled “Acknowledgements”, “Dedications”, or “History”, the requirement (section 4) to
Preserve its Title (section 1) will typically require changing the actual title.

Termination

You may not copy, modify, sublicense, or distribute the Document except as expressly provided under this License. Any
attempt otherwise to copy, modify, sublicense, or distribute it is void, and will automatically terminate your rights under
this License.

However, if you cease all violation of this License, then your license from a particular copyright holder is reinstated (a)
provisionally, unless and until the copyright holder explicitly and finally terminates your license, and (b) permanently, if the
copyright holder fails to notify you of the violation by some reasonable means prior to 60 days after the cessation.

Moreover, your license from a particular copyright holder is reinstated permanently if the copyright holder notifies you of
the violation by some reasonable means, this is the first time you have received notice of violation of this License (for any
work) from that copyright holder, and you cure the violation prior to 30 days after your receipt of the notice.

Termination of your rights under this section does not terminate the licenses of parties who have received copies or rights
from you under this License. If your rights have been terminated and not permanently reinstated, receipt of a copy of some
or all of the same material does not give you any rights to use it.

Future revisions of this license

The Free Software Foundation may publish new, revised versions of the GNU Free Documentation License from time to
time. Such new versions will be similar in spirit to the present version, but may differ in detail to address new problems or
concerns. See http://www.gnu.org/copyleft/.

Each version of the License is given a distinguishing version number. If the Document specifies that a particular numbered
version of this License “or any later version” applies to it, you have the option of following the terms and conditions either
of that specified version or of any later version that has been published (not as a draft) by the Free Software Foundation.
If the Document does not specify a version number of this License, you may choose any version ever published (not as a
draft) by the Free Software Foundation. If the Document specifies that a proxy can decide which future versions of this
License can be used, that proxy's public statement of acceptance of a version permanently authorizes you to choose that
version for the Document.

Relicensing

“Massive Multiauthor Collaboration Site” (or “MMC Site” ) means any World Wide Web server that publishes copyrightable
works and also provides prominent facilities for anybody to edit those works. A public wiki that anybody can edit is an
example of such a server. A “Massive Multiauthor Collaboration” (or “MMC") contained in the site means any set of
copyrightable works thus published on the MMC site.

“CC-BY-SA"” means the Creative Commons Attribution-Share Alike 3.0 license published by Creative Commons Corporation,
a not-for-profit corporation with a principal place of business in San Francisco, California, as well as future copyleft versions
of that license published by that same organization.

“Incorporate” means to publish or republish a Document, in whole or in part, as part of another Document.

An MMC is “eligible for relicensing” if it is licensed under this License, and if all works that were first published under this
License somewhere other than this MMC, and subsequently incorporated in whole or in part into the MMC, (1) had no
cover texts or invariant sections, and (2) were thus incorporated prior to November 1, 2008.

The operator of an MMC Site may republish an MMC contained in the site under CC-BY-SA on the same site at any time
before August 1, 2009, provided the MMC is eligible for relicensing.
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